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 Resumen 

La gasificación de la biomasa despierta un constante interés en el campo de la energía 

sostenible, usándola como una alternativa frente a la tecnología de combustión 

tradicional, sobre todo por la reducción en la emisión de polvo y gases tóxicos. En la 

gasificación se realiza una conversión termoquímica de material orgánico, biomasa, 

obteniéndose un producto gaseoso de gran interés conocido como gas de síntesis. El 

enfoque actual sobre energías sustentables está dirigido a la obtención de bioetanol a 

partir de compuestos orgánicos que generalmente provienen de residuos; sin embargo, 

existe un amplio campo de estudio en redirigir el curso del producto sacarificado hasta 

la gasificación para elevar las eficiencias energéticas, así como el uso de catalizadores 

para favorecer la velocidad de reacción y obtención del gas de interés.  

Por lo tanto, el objetivo de esta investigación fue la simulación de un proceso de 

gasificación de biomasa de banano y condiciones de operación del sistema durante el 

proceso. Mediante Ansys estudiantil, se establecieron las condiciones operativas de 

temperaturas y velocidades del fluido, cuyos valores fueron adoptados en la simulación 

de la reacción gasificación. De esta manera se obtuvo una temperatura de operación de 

604.05 °C dentro del reactor a presión atmosférica, la temperatura del agente gasificante 

fue de 226.85 °C. Se desarrolló el modelo matemático de la reacción a través de la 

cinética de reacción tomando como referencia el estudio cinético a base de glucosa 

mediante el mecanismos Langmuir-Hinshelwood, el mismo que implica la adsorción de 

los reactivos, reacción superficial catalítica y desorción de los productos de las 

reacciones dominantes: la reacción del cambio de agua-gas (WGS), las reacción inversa 

del reformado seco de metano (RDRM) y las reacciones de reformado de metano con 

vapor (SRM), con las cuales se obtuvo el modelo que describe la evolución del flujo 

molar con respecto al tiempo y coordenada Z de los principales productos, es decir, 

hidrógeno (H2), metano (CH4), monóxido de carbono (CO), dióxido de carbono (CO2) y 

agua (H2O). Los resultados del flujo molar con respecto al tiempo considerando 25 s de 

reacción fueron 0.16 mol/s de H2, 0.08 mol/s de CO, 0.16 mol/s de CO2, 0.12 mol/ de 

CH4 y 0.10 mol/s de H2O. Los resultados respecto a eje longitudinal Z, pese a haber 

trabajado a una presión de 2 bares, no presentaron variación en cuanto al 

comportamiento de la curva. También se analizó la relación H2/CO que presentó un valor 

de 2.2 para ambos casos. 

 

Palabras clave: Simulación. Biomasa. Gasificación. Glucosa. Temperatura.  



 
 

 

Jessica Mayli Gaona Cumbicos, Kelly Dayanna Naula Duchi  Página 3  

Abstract 

Biomass gasification technology is of constant interest in the field of sustainable energy, 

being used as an alternative to traditional combustion technology, especially due to the 

reduction in the emission of dust and toxic gases. In gasification, hermochemical 

conversion of organic material, biomass, is carried out, obtaining a gaseous product of 

great interest known as synthesis gas. The current focus on sustainable energies is 

aimed at obtaining bioethanol from organic compounds that generally come from waste; 

however, there is a wide field of study in redirecting the course of the saccharified product 

to gasification to increase energy efficiencies, as well as the use of catalysts to favor the 

reaction rate and obtain the gas of interest.  

Therefore, this research’s objective was to simulate a banana biomass gasification 

process and system operating conditions during the process. Using Ansys students, the 

operating conditions of temperatures and fluid velocities were established, whose values 

were adopted in the simulation of the gasification reaction. In this way, an operating 

temperature of 604.05 °C was obtained inside the reactor at atmospheric pressure; the 

temperature of the gasifying agent was 226.85 °C. The mathematical model of the 

reaction was developed through the reaction kinetics taking as reference the kinetic 

study based on glucose using the Langmuir-Hinshelwood mechanism, which involves 

the adsorption of the reactants, catalytic surface reaction. desorption of the products of 

the dominant reactions: the water-gas shift reaction (WGS), the reverse dry methane 

reforming reaction (RDRM) and the steam methane reforming reactions (SRM), with 

which the model describing the evolution of the molar flux with respect to time and Z-

coordinate of the main products, i.e. hydrogen (H2), methane (CH4), carbon monoxide 

(CO), carbon dioxide (CO2) and water (H2O), was obtained. The results of the molar flux 

concernig time considering 25 s of reaction were 0.16 mol/s of H2, 0.08 mol/s of CO, 0.16 

mol/s of CO2, 0.12 mol/ of CH4 and 0.10 mol/s of H2O, the molar fluxes cocnerning 

concerning the longitudinal axis Z with a varying pressure of 2 bars, did not vary in 

comparison with the previous ones. The H2/CO ratio was also analyzed and showed a 

value of 2.2 for both cases. 

 

Keywords: Simulation. Biomass. Gasification. Glucose. Temperature. 
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NOMENCLATURA 

𝐾𝑆𝑅𝑀                      Constante de velocidad de reacción concentrada para SRM 

𝐾𝐻2                         Constante de velocidad de adsorción del Hidrógeno 

𝐾𝐻2𝑂                       Constante de velocidad de adsorción del Agua 

𝐾𝐶𝑂                         Constante de velocidad de adsorción del Monóxido de Carbono 

𝐾𝐶𝑂2                        Constante de velocidad de adsorción del Dióxido de Carbono 

𝐾𝐶𝐻4                        Constante de velocidad de adsorción del Metano 

𝑃𝐻2                          Presión del Hidrógeno 

𝑃𝐻2𝑂                        Presión del Agua 

𝑃𝐶𝑂                          Presión del Monóxido de Carbono 

𝑃𝐶𝑂2                         Presión del Dióxido de Carbono 

𝑃𝐶𝐻4                         Presión del Metano 

𝑘𝑗                            Constante de velocidad para la j-ésima reacción 

𝑘𝑗
0                           Factor pre-exponencial para la j-ésima reacción 

𝐸𝑎                           Energía de activación para la j-ésima reacción 

𝑇                             Temperatura de reacción 

𝑇0                            Temperatura estándar 

𝑅                             Constante de los gases ideales 

𝑘𝑖                             Constante de velocidad de adsorción del componente i 

𝑘𝑖
0                           Factor pre-exponencial para el componente i 

∆𝐻𝑖
𝑎𝑑𝑠                     Calor de adsorción para el componente i del catalizador 

𝑟𝑆𝑅𝑀                        Velocidad de reacción para el cambio de agua-gas 

𝑟𝑊𝐺𝑆                        Velocidad de reacción para el reformado de metano con vapor 

𝑟𝑅𝐷𝑅𝑀                      Velocidad de reacción para el reformado en seco de metano 

𝑣𝑖,𝑗                              Coeficiente estequiométrico del componente i en la j-ésima reacción 

∀                              Volumen 

𝑑𝑛𝑖

𝑑𝑡
                            Evolución de los moles del componente i con respecto al tiempo 

𝑚𝑐𝑎𝑡                         Masa del catalizador 

𝑚                             Masa del reactivo 

𝜌                              Densidad del reactivo. 

𝑛                              Número de moles 

𝑃𝑀                           Peso molecular 

𝑑𝑛̇𝑖

𝑑∀
                            Variación del flujo molar con respecto al volumen del reactor 
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𝑑𝑛̇𝑖

𝑑𝑍
                            Variación del flujo molar con respecto al eje longitudinal 

𝐴𝑐                            Área transversal 

𝜀                              Porosidad del lecho 

𝑚̇                             Flujo másico 

𝑛̇                              Flujo molar de cada componente 

𝑡                               Tiempo de reacción 

𝐷                              Diámetro interno del reactor 

𝑉𝑙𝑒𝑐ℎ𝑜                        Volumen del lecho 

𝑟                               Radio del lecho 

ℎ                               Altura del lecho 

𝑉𝑇𝑒𝑠𝑓                         Volumen total de las esferas 

𝑟𝑒𝑠𝑓                           Radio de las esferas 

𝑁°                             Número de esferas empaquetadas en el lecho catalítico 

𝐾𝑄                             Coeficiente de la resistencia cuadrática 

𝜕𝑝

𝜕𝑥𝑖
                             Gradiente de la caída de presión en la dirección de i 

𝑈𝑖                              Velocidad local en la dirección i 

𝑉0                              Velocidad superficial o ficticia 

𝜇                               Viscosidad dinámica del fluido 

𝜙𝑠                             Factor de forma 

𝐷𝑝                            Diámetro de partícula 

𝑄                              Caudal volumétrico 

𝜎                              Densidad del área superficial 

𝑅𝑒                            Número de Reynolds 
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CAPITULO 1: INTRODUCCIÓN 

La biomasa constituye una de las fuentes de energía más prometedoras siendo 

considerada como una alternativa a las convencionales. La capacidad de 

transformación de la biomasa a energía en forma de gas, juega un papel importante 

para reducir la dependencia en el uso de combustibles fósiles. Gracias a esta primicia, 

el pilar principal y el eje en el cual giran varias investigaciones, es en la producción de 

energía renovable haciendo uso de esta materia prima (Durazno & Alberto, 2018). La 

energía puede ser generada mediante combustión directa, cocción, pirólisis, digestión 

anaeróbica y gasificación. Por medio de estas tecnologías se puede lograr obtener un 

recurso energético mucho más eficiente al reducir las emisiones de gases de efecto 

invernadero (Velázquez Martí, 2018).  

Una de las tecnologías más usadas actualmente, es la gasificación de biomasa, la cual 

consiste en un proceso termoquímico en el que, a ciertas condiciones de temperatura y 

con la presencia de un agente gasificante, generalmente vapor de agua; permite obtener 

un gas de interés con elevado poder calorífico. En síntesis, ser realiza primero la 

hidrolisis de la biomasa, seguida de la gasificación en presencia de catalizadores 

(Bhushan et al., 2019). 

Debido a su disponibilidad de biomasa de banano y a que Ecuador se encuentra en el 

ranking mundial de países exportadores de banano, es de entender que dicha industria 

genera grandes cantidades de residuos que pueden ser usados como materia prima 

para la gasificación (Organización de las Naciones Unidas para la Agricultura y la 

Alimentación (FAO), 2020). Sin embargo, la principal limitante de este proceso, es la 

generación de alquitranes y su baja eficiencia energética. La solución a dicho problema 

es el uso de catalizadores y mediante el uso de reactores de lecho fijo que son los que 

mejor evitan dichas barreras (Bhushan et al., 2019). En este tipo de reactor, la velocidad 

de fluidización de materia prima se mantiene por sobre la velocidad del agente 

gasificante; quedando el material “inmóvil” dentro del reactor (Boujjat et al., 2019). 

Un grupo de investigación de la Universidad Autónoma de Zacatecas, ha trabajado con 

gasificaciones usando compuestos modelos que se obtienen de la biomasa, estos son 

glucosa y lignina, en dichos estudios proponen modelos cinéticos y termodinámicos que 

involucran únicamente balances elementales de Carbono, Oxígeno, Hidrógeno y demás 

hidrocarburos siempre y cuando cumplan C6 (Cruz, 2018), con esto de dejan sentadas 

bases para análisis de gasificaciones de glucosa aislada pero proveniente de biomasa. 
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Dicho estudio se puede llevar a cabo con el uso de software especializado en el que se 

simula el proceso con condiciones próximas a las reales sin necesidad de hacer uso 

físico de materias primas o recursos. El presente trabajo tiene como objetivo la 

simulación del proceso de gasificación de biomasa mediante el uso de dos 

herramientas. Ansys, el cual es un software que permite estudiar el comportamiento 

térmico, fluido-dinámico dentro del proceso de gasificación de biomasa haciendo uso de 

dinámica de fluidos computacional y además facilita otras herramientas tales como el 

análisis térmico para observar la distribución de temperatura a través de un sistema 

(Esquivel & Randal, 2017). Por otra parte, Python, el cual es un software de acceso libre 

especializado en la resolución de ecuaciones diferenciales específicas para algún tipo 

de reacción, permite estudiar la conversión de la materia prima en sus productos. Y es 

gracias al uso en conjunto de estas dos herramientas, que es posible determinar 

condiciones operativas que permiten la generación del gas de síntesis usando 

compuestos modelos que optimizan el proceso. 
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OBJETIVOS 

 

OBJETIVO GENERAL 

Simular el proceso de gasificación catalítica de biomasa de banano en la producción de 

hidrógeno; en un reactor de lecho fijo, mediante el Software Ansys. 

 

OBJETIVOS ESPECÍFICOS 

• Modelar el reactor y el proceso de obtención de gas de síntesis mediante 

Ansys. 

• Validar el modelo matemático basándose en resultados de trabajos previos 

publicados. 

• Determinar los parámetros de entrada que optimizan la producción de 

hidrógeno. 
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CAPÍTULO 2: MARCO TEÓRICO 

2.1. Biomasa  

La biomasa es la materia orgánica no fosilizada proveniente de residuos de plantas o 

animales; cultivos agrícolas y materiales de desecho, desechos biogénicos y estiércol 

animal o aguas residuales humanas. Esta supone una buena fuente de energía ya que 

resulta principalmente de residuos de materia usada convencionalmente a gran escala. 

Cuando esta materia es transformada en combustible, el resultado se denomina 

biocombustible (Velázquez Martí, 2018). 

La biomasa constituye una fuente de energía solar que se origina de la absorción de 

CO2 realizada por las plantas para luego ser convertida en materia vegetal (Aydin, 2019). 

Las tres fases principales de la biomasa son: materia fluida, materia orgánica y materia 

inorgánica.  

La materia orgánica es aquella fase sólida que puede ser no cristalina, como la celulosa, 

hemicelulosa, lignina y algunos extractos. Y cristalina como los oxalatos minerales. La 

materia inorgánica, al igual que la orgánica, se encuentra en estado sólido y puede ser 

cristalina, semicristalina y amorfa. Por último, la materia fluida es aquella que se 

encuentra de manera gaseosa o líquida (Gamboa, 2021). 

2.2. Tipos de biomasa  

La biomasa puede presentarse o generarse de diversas maneras, puede provenir de las 

transformaciones naturales, de los cultivos y cosechas e inclusive de las 

transformaciones o residuos industriales, siempre y cuando exista la presencia de 

materia orgánica (Nuñes, 2012). 

2.2.1. Plantaciones energéticas 

Las plantaciones energéticas son aquellas plantaciones como árboles o plantas que han 

sido cultivadas con el único propósito de generar energía. Generalmente los árboles y 

plantas son de crecimiento rápido de bajo mantenimiento, donde la tierra de cultivo no 

necesita de un gran valor productivo. El tiempo de cosecha puede variar entre los tres y 

diez años. Además, este tipo de cultivos pueden ayudar al control de la degradación y 

la erosión de los suelos (Nuñes, 2012). 

Entre los cultivos agrícolas empleados en la producción de energía se puede citar los 

siguientes: caña de azúcar, maíz, trigo, sorgo, palma de aceite, soya o girasol, otras 

plantas como las algas son empleadas en la generación de combustibles líquidos (etanol 
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y biodiesel). Cabe recalcar que, para que las plantaciones energéticas resulten 

rentables, deben ir a la par con la producción agrícola paralela de maíz, caña de azúcar, 

etc., puesto que para la generación de energía a gran escala es necesario grandes 

extensiones de tierra (Nuñes, 2012). 

2.2.1. Residuos forestales 

Una importante fuente de biomasa, es aquella que proviene a partir de los residuos 

forestales, debido a que por cada árbol talado alrededor del 20% es aprovechado 

económicamente, el 40% es convertido en aserrín, astillas y corteza, mientras que el 

otro 40% se convierte en residuos forestales, es decir, ramas y raíces. Los desechos 

resultantes suelen ser usados para la generación de calor, combustión o en la 

producción de vapor (BUN-CA, 2002; Nuñes, 2012). 

2.2.1. Residuos agropecuarios 

Son aquellas plantaciones que no poseen fines alimentarios. Generan alrededor de 60% 

de residuos, este valor puede variar entre 20% y 40% de residuos cuando se utilizan en 

diferentes procesos. Muchos de estos residuos son dejados en el campo, provenientes 

del arroz, café, caña de azúcar, etc., (BUN-CA, 2002; Nuñes, 2012). 

2.2.1. Residuos industriales 

La actividad industrial puede generar grandes cantidades de residuos, siendo la 

industria alimenticia una de las más importantes, este tipo de biomasa resulta de los 

residuos de diferentes tipos de carnes, vegetales, pudiendo estar en estado sólido o 

líquido, las cuales poseen un elevado contenido de carbohidratos y azúcares que 

pueden ser aprovechados para la producción de combustibles gaseosos. Además, 

también pueden presentarse residuos en forma de grasas y aceites (Nuñes, 2012). 

2.2.1. Residuos urbanos 

Estos residuos constituyen una biomasa de diferentes fuentes tales como: residuos 

alimenticios, papel, cartón, madera y aguas negras, constituidas principalmente por 

materia orgánica que pueden ser empleadas en la generación de energía y evitar la 

contaminación ambiental que estas pueden generar al momento de su descomposición. 

Alrededor del 80% de los estos residuos pueden ser aprovechados para la producción 

de energía (Nuñes, 2012). 

2.3. Biomasa como fuente de energía  

Actualmente, la biomasa residual constituye una fuente importante de energía renovable 

con peso elevado sobre la canasta energética mundial. Según Wang et al., (2020), 

aproximadamente la mitad de la energía renovable usada en el año 2017, provino de 
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energía moderna, esto representa el 12,4% del consumo total de energía. Las 

aplicaciones de la energía obtenida de las distintas tecnológicas de conversión varían 

debido a diferentes factores. Dentro de estos factores se encuentran la masa, densidad, 

volumen, origen y disponibilidad (Karac, 2017). 

Según pronósticos de La Agencia Internacional de Energía, en el periodo de 2018-2023, 

se estima que la energía obtenida a través de la biomasa presenta una tasa de 

crecimiento del 30%; este crecimiento puede ser explicado debido al interés que 

despierta con respecto a sus numerosas ventajas sobre los otros tipos de energía. 

Algunas de estas ventajas son, la reducción a la dependencia de uso de combustibles 

fósiles, la energía obtenida de la biomasa es la única que puede ser convertida en 

combustible líquido, es abundante, renovable y fácil de producir, pero su principal 

atractivo radica en que se concibe como “Carbono neutral”, es decir, las emisiones netas 

de gases de efecto invernadero, equivalen a cero (Wang et al., 2020). 

La conversión de la biomasa hasta la generación de energía puede tomar diferentes 

rutas. Las principales son bioquímica y térmica (Mousa et al., 2017). 

2.3.1. Conversión bioquímica 

Ocurre debido a la acción de bacterias o enzimas, se caracteriza por ser un proceso 

lento, cuya ventaja se da en la mínima cantidad de energía necesaria para la conversión. 

Los principales productos que resultan de este proceso son el metano, dióxido de 

carbono y residuos sólidos de carbono (Dayton & Foust, 2020). 

2.3.1. Conversión térmica 

Esta conversión se logra a través de diferentes procesos, tales como la pirólisis, 

licuefacción, gasificación o combustión (Mousa et al., 2017). 

- Pirólisis: De esta reacción los productos resultantes son carbón vegetal, 

bioaceite y gas pirolítico. El principal producto de interés es el bioaceite compuesto de 

alcoholes, cetonas, aldehídos, fenoles, éteres y ésteres, azúcar, furanos, alquenos, 

nitrógeno y demás compuesto de oxígeno; se obtiene con rendimientos del 50% al 70% 

en peso.  

El gas pirolítico está compuesto de CO, CO2, NOx, SOx, etc. llegando a alcanzar 

rendimientos del 13% al 25% en peso. Por último, el carbón vegetal obtiene 

rendimientos del 12% al 15% en peso (Hu & Gholizadeh, 2019).  

- Licuefacción: Esta tecnología es usada para convertir biomasa lignocelulósica 

sólida en líquida. Consiste en licuar directamente la biomasa con solventes afines como 

agua, fenol, alcoholes bajos en carbono, sulfolano, entre otros líquidos iónicos. Los 
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productos obtenidos son glucósidos, ácido levulínico, levulinato de etilo, alcohol 

furfurílico, furfural y algunos compuestos aromáticos. Alcanza rendimientos del 30% al 

50% (Guo et al., 2019).  

- Combustión: Consiste en la oxidación de los componentes de la biomasa a 

elevadas temperaturas con una cantidad determinada de oxígeno para que pueda darse 

la reacción. Es una de las tecnologías de conversión menos preferidas debido al reto 

que conlleva el control de emisiones de NOx que se producen al combustionar 

directamente la biomasa. El costo de acondicionamiento (desnitrificación) de biomasa e 

implementación de sistemas de control de emisiones, también influyen 

considerablemente el uso de esta tecnología de manera frecuente (Mladenović et al., 

2018). 

- Gasificación: La gasificación, al igual que la combustión, se lleva a cabo a 

elevadas temperaturas y en presencia de oxígeno que generalmente proviene del aire 

(agente gasificante); el producto que se espera obtener es el gas de síntesis compuesto 

principalmente de hidrógeno y monóxido de carbono. Para poder llevar a cabo este 

proceso se requieren conocer, sus etapas, la configuración y tamaño del gasificador, 

características de la materia prima y los parámetros de operación (Mazaheri et al., 

2019). 

2.4. Biomasa de banano 
El banano pertenece al orden Zingiberales, de la familia Musaceae y género Musa, es 

una planta herbácea perenne de gran tamaño entre 3 a 7 metros de altura. Durante el 

proceso de siembra y cosecha de banano se generan grandes cantidades de desechos, 

los mismos que no son empleados de manera óptima. Aproximadamente el 30% de la 

biomasa del racimo de banano es aprovechada, mientras que, la parte restante es 

desechada para procesos de compostaje o considerada como contaminante al ser 

eliminada en cuerpos de agua, generando así un problema ambiental (Palacios & 

Zalamea, 2016). 

De la cosecha de la planta de banano se genera un aproximado del 88% en peso de 

residuos agrícolas, siendo el tronco, es decir, el pseudotallo, el principal residuo. Uno 

de los principales componentes de estos residuos es la celulosa, la misma que puede 

ser empleada para la generación de energía. Además, la biomasa tiene un gran 

potencial en la absorción de metales de aguas y suelos contaminados, por lo que se 

convierte en una amenaza o gran desafío debido a la demanda energética que se origina 

para la generación de los combustibles gaseosos y la recuperación de los metales 

pesados adsorbidos (A. Kumar & Reddy, 2020). 
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2.4.1. Biomasa de banano en Ecuador 

Según la Organización de las Naciones Unidas para la Agricultura y la Alimentación 

(FAO), 2020, en dicho año, 140 países alrededor de todo el mundo produjeron 

aproximadamente 119,8 millones de toneladas de banano. India encabeza la lista con 

alrededor de 31 millones de toneladas de la producción mundial, le siguen China, 

Indonesia, Brasil y Ecuador que ocupó el quinto lugar con cerca de 6 millones de 

toneladas. 

 

Figura 1. Producción mundial de banano en el año 2020 

Fuente: (Organización de las Naciones Unidas para la Agricultura y la Alimentación (FAO), 

2020). 

Al ser uno de los principales productores de banano a nivel mundial, Ecuador genera 

una gran cantidad de residuos.  

En el Ecuador se generan alrededor de 350141 toneladas métricas de residuos 

lignocelulósicos libres de agua provenientes de las plantaciones de banano. Debido a la 

gran cantidad de residuos generados del banano se han enfocado investigaciones con 

la finalidad de aprovechar la biomasa del banano para diferentes aplicaciones en 

cuestiones energéticas alternas (Palacios & Zalamea, 2016). 

2.5. Composición de la biomasa  

La composición química de la biomasa es una red compleja formada por tres 

biopolímeros estructurales (Lignina, celulosa y hemicelulosa) además de otros 

componentes orgánicos que son llamados extractivos (Dayton & Foust, 2020). 

2.5.1. Lignina 

La lignina es una compleja estructura compuesta de polímeros reticulados formados por 

moléculas fenólicas. Los principales alcoholes por los que está compuesto son p-

cumarilo, coniferilo y sinapilo (Kumar & Dixit, 2021). Su peso molecular es bastante 

elevado y por estas mismas propiedades es capaz de otorgarle a la pared celular el 
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soporte estructural, impermeabilidad y resistencia contra la degradación microbiana 

(Bhushan et al., 2019b). 

 

Figura 2. Estructura de la lignina 

Fuente: (Chávez, 2013).  

La lignina brinda resistencia e hidrofobicidad a las paredes celulares de las plantas 

protegiéndolas de la degradación microbiana. Es el segundo componente más 

abundante y comprende aproximadamente el 30% del carbono orgánico no fósil de la 

naturaleza (Bakker et al., 2020); su principal aplicación como fuente renovable es en la 

obtención de adhesivos y revestimientos (Megashah et al., 2019).  

2.5.2 Celulosa 

Es el componente que se encuentra en mayor proporción, se trata de un polímero 

formado por unidades de β D-glucosa unidas por enlaces covalentes; su composición 

da como resultado una estructura ordenada y compacta en la que se forman fibrillas 

mediante puentes de hidrógeno y fuerzas de Van Der Waals. No se trata de una 

estructura completamente cristalina ya que dichas fibrillas son amorfas y entrelazadas, 

quitándole esa propiedad ya que entre sus microporos ocurre la penetración de 

moléculas pequeñas (Flores-Velázquez et al., 2020). 

 

Figura 3. Estructura de la celulosa 

Fuente: (Abu Ghalia & Dahman, 2017).  

La celulosa posee propiedades biodegradables y se encuentra fácilmente disponible (Ai 

et al., 2021). No es digerible por los seres humanos, suele usarse de alimento para 

algunos herbívoros. Algunos protozoos que habitan en el intestino de los insectos, 

también son capaces de digerir la celulosa. Sin embargo, el uso industrial que posee es 
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la producción de papel y fibras, como base para la producción de plásticos y en las 

películas fotográficas (Bhushan et al., 2019b). 

2.5.3  Hemicelulosa 

La hemicelulosa es un polisacárido que se caracteriza por su relativa irregularidad 

macromolecular (Bajpai, 2018). Esto significa que posee una mayor presencia de 

unidades monoméricas y ramificaciones. Es el segundo componente de mayor 

abundancia en la estructura vegetal y se diferencia de la celulosa debido a que consta 

de varios monosacáridos de pentosas y hexosas, tales como manosa, xilosa, galactosa, 

fructosa, arabinosa y ácido glucorónico/galacturónico. La proporción en la que cada uno 

se encuentra depende del tipo de biomasa (Reinoso et al., 2017).  

La biodegradación, degradación térmica y absorción de humedad de la fibra, es atribuida 

a la presencia de hemicelulosa que se encuentra en las paredes celulares primarias 

(Patel & Parsania, 2018). El principal factor a controlar son los residuos de ácido que le 

conceden una alta capacidad hidrofílica haciendo que se le facilite la absorción en agua, 

por lo tanto, la vuelve más propensa a la aparición de microorganismos (Naheed et al., 

2021). 

 

Figura 4. Estructura de la hemicelulosa 

Fuente: (Machmudah et al., 2017).  

2.5.4 Composición de la biomasa de banano 

En la tabla 1, se especifica el porcentaje de Lignina, Celulosa y Hemicelulosa de los de 

banano.  

Tabla 1. Composición de lignina, celulosa y hemicelulosa de la biomasa del banano, en base 

seca. 

Residuo de banano Lignina (%) Celulosa (%) Hemicelulosa (%) 

Hojas 8,5 36,3 27,39 

Pseudotallo 5,2 35,3 24,9 

Raquis 9,85 30,6 15,7 

Fuente: (Palacios & Zalamea, 2016).  
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2.6. Glucosa como especie modelo de biomasa 

La glucosa es uno de los componentes de la celulosa, se trata de un monosacárido de 

fórmula química y unidad repetitiva C6H12O6 (Gurung & Jialal, 2019). Como se muestra 

en la Tabla 1, la celulosa es el principal componente que estructura la biomasa, estos 

contenidos varían, llegando a alcanzar hasta un 50.3% dependiendo de la parte de la 

planta que se utilice (Cruz, 2018). Al presentar la biomasa una característica potencial 

como fuente de energía renovable, la mayoría de autores se enfocan en la producción 

de bioetanoles a fin de fomentar un modelo económico energético sustentable y 

principalmente sostenible con el medio ambiente (Llangari, 2018). 

La glucosa se obtiene del desdoblamiento de la molécula de celulosa a través de la 

hidrólisis complementado a pretratamientos enzimáticos. Es por ello que, Cruz I. ( 2018) 

en su estudio “Producción de hidrógeno a través de la gasificación de glucosa usando 

catalizadores de γ-Al2O3 con Ni, Ce y La e interpretación de resultados usando un 

modelo No-estequiométrico”, propone el de uso de glucosa como modelo de biomasa 

manejando parámetros de operación basados en un modelo de equilibrio de gasificación 

de biomasa. 

2.7. Gasificación 

El hidrógeno es un combustible gaseoso limpio, posee un alto poder calorífico (120 

MJ/Kg), el mismo que resulta en agua mediante la combustión, convirtiéndolo de esta 

manera en una energía sustentable para el medio ambiente. Se ha evidenciado que el 

uso de hidrógeno como alternativa para la disminución de emisiones es una de las más 

prometedoras, siendo aún más favorable cuando este se obtiene a partir de fuentes 

renovables, como por ejemplo la biomasa o agua. Generalmente, la forma convencional 

para la obtención o producción de hidrógeno se da mediante el reformado con vapor, 

oxidación parcial (gasificación) o la pirólisis de fuentes fósiles o renovables y también 

mediante la electrólisis del agua. Sin embargo, esta última presenta una alta demanda 

energética por lo que no es comúnmente empleada (Rodríguez Correa & Kruse, 2018).  

La gasificación es la oxidación térmica parcial, que tiene como objetivo convertir la 

biomasa con una alta proporción de productos gaseosos tales como dióxido de carbono 

(CO2), agua (H2O), monóxido de carbono (CO), Hidrógeno (H2), metano (CH4), entre 

otros hidrocarburos gaseosos. Además, durante el proceso resultan pequeñas 

cantidades de carbón en forma sólido, cenizas y otros compuestos condensables como 

alquitranes y aceite. Las propiedades de la biomasa, materias primas y las condiciones 

de operación influyen significativamente en la formación de dichos productos. Mediante 
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el uso de un agente gasificante es posible realizar la oxidación parcial de la biomasa 

(Tacuri, 2021). Este método es considerado como el más eficiente para convertir la 

biomasa en combustible gaseoso (Yu et al., 2021). 

En el proceso de gasificación de biomasa se pueden distinguir dos etapas de acuerdo 

a la evolución o formación de los productos. En la etapa I se forma carbón con altos 

contenidos de H2 y O2, junto con el craqueo de sustancias volátiles. A medida que la 

temperatura aumenta, el carbón vegetal es convertido en carbón fijo, el mismo que 

reacciona con el agente gasificante para dar lugar a la formación de gas de síntesis en 

la etapa II (Yu et al., 2021). 

Generalmente un proceso de gasificación está constituido de diferentes pasos, tales 

como, secado, descomposición térmica o pirólisis, combustión parcial de algunos gases, 

vapores y carbón y finalmente se da la gasificación de los productos de descomposición 

como se muestra en la figura 5. 

 

Figura 5. Etapas del proceso de gasificación 

Fuente: (Barriga, 2013) 

Existen diversos tipos de biomasa cuya composición varía de acuerdo a la fuente de la 

cual proviene. Por ello, aquellas que presentan un mayor contenido de celulosa y 

hemicelulosa generan mayores concentraciones de CO y CO2 en el producto, mientras 

que elevados contenidos de lignina generan mayores concentraciones de metano (CH4) 

(Yu et al., 2021). 

En la tabla 2 se muestra la degradación de la biomasa en términos de materia 

lignocelulósica en función de la temperatura, como se puede observar la 

descomposición de la materia comienza a los 373 K (100 °C) con la eliminación de la 

humedad contenida. 



 
 

 

Jessica Mayli Gaona Cumbicos, Kelly Dayanna Naula Duchi  Página 31  

Tabla 2. Descomposición de la biomasa (materia lignocelulósica) 

Zona Intervalo de 

temperatura 

Tipo de materia 

I <373 K Evolución de la humedad 

II  373 – 523 K Tiene lugar al inicio de la descomposición de 

extractables y descomposición de la hemicelulosa. 

III  523 – 633 K Descomposición de la celulosa. 

IV  633 – 733 K Descomposición de la lignina. 

V >733 K Oxidación del carbón fijo. 

Fuente: (Flores Guamán, 2022). 

2.8. Agentes Gasificantes  

En las reacciones de gasificación, lo agentes gasificantes juegan un papel clave, los 

mismos poseen diferentes reactividades y composición. Generalmente en el proceso se 

emplean vapor de agua, aire u oxígeno (O2), dióxido de carbono (CO2) o sus mezclas y 

agua supercrítica. La selección del tipo de gasificante a emplear va a depender de la 

composición requerida en el gas de síntesis y el consumo energético. 

2.8.1. Aire u Oxígeno 

El aire comúnmente es el más empleado debido a su fácil disponibilidad y bajos costos; 

sin embargo, por su contenido de nitrógeno provoca una disminución en el poder 

calorífico del gas de síntesis. Por ello es recomendable el uso de aire rico en oxígeno 

con la finalidad de obtener un gas de síntesis con un poder calorífico (Situmorang et al., 

2020).  

Es determinante la cantidad de oxígeno que se requiere para que la reacción se lleve 

cabo de manera deseada. Cuando el oxígeno que reacciona se encuentra en cantidades 

limitadas, favorece la formación en mayor cantidad de CO; sin embargo, si dicha 

cantidad excede cierto límite a medida que aumenta, dominará el consumo de CO 

(Shahbaz et al., 2020). 

2.8.1. Vapor de agua 

El vapor permite obtener durante el proceso de gasificación mayores contenidos de 

hidrógeno y menos alquitrán. Para procesos con este gasificante es necesario más 

energía, la misma que es requerida para las reacciones endotérmicas dadas en las 

reacciones de vapor primarias y secundarias y durante la reacción de gas de agua. Para 

mejorar la velocidad de reacción durante el proceso, se suele realizar una mezcla aire-
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vapor, para que las oxidaciones parciales exotérmicas otorguen energía a las 

reacciones endotérmicas (Situmorang et al., 2020). 

2.8.1. Agua supercrítica 

El agua supercrítica se encuentra a una temperatura superior a 374 °C con presiones 

mayores a 22,1 MPa, presenta una alta solubilidad, reactividad y difusividad, disuelve la 

materia orgánica y productos gaseosos. Las reacciones involucradas en el proceso de 

gasificación pueden llevarse a cabo en atmósferas a bajas temperatura sin la necesidad 

de emplear un catalizador, evitando así la formación de NOX y SOX (Zhang et al., 2019). 

Los productos obtenidos son principalmente el hidrógeno y dióxido de carbono, durante 

el proceso se dan altas tasas de conversión, dependiendo de factores tales como la 

materia prima, el tipo de catalizador, el diseño del reactor o las condiciones de operación 

del sistema. Los hidrocarburos de cadena corta (etano, propano, propeno) y el monóxido 

de carbono se forman en pequeñas cantidades (Rodríguez Correa & Kruse, 2018). 

2.9. Parámetros que influyen en la gasificación  

Entre los parámetros que influyen en el proceso de gasificación están las características 

de la biomasa y el agente gasificante, la concentración de la biomasa, el tiempo de 

residencia, la temperatura de gasificación, catalizador de la reacción y la presión del 

reactor (Zhang et al., 2019). 

2.9.1. Características de la biomasa 

Además de los principales componentes de la biomasa (lignina, celulosa y 

hemicelulosa), posee un cierto contenido de minerales como K, Mg, Mn, Na, Ca, Cu, Co 

Si y Zn. Estos se encuentran formando sales y óxidos (carbonatos, fosfatos, sulfatos y 

cloruros). El factor determinante de estos minerales, se observa durante la reacción de 

gasificación ya que algunos de ellos pueden actuar como catalizadores. De la misma 

forma, la composición mineralógica puede llegar a limitar la temperatura de trabajo al 

actuar sobre la temperatura de fusibilidad de cenizas (Acevedo Juan & Arenas, 2019). 

2.9.1. Humedad 

La humedad que alberga la estructura de cada planta, depende de cómo ésta es 

absorbida desde la tierra y distribuida. Parte de ella se desplaza hacia las hojas 

mediante las secciones estrechas de las mismas. La humedad influye directamente 

sobre el estado de descomposición de la biomasa, si el contenido de humedad de la 

biomasa aumenta, la tasa de descomposición se reduce (Singh Siwal et al., 2020). El 

proceso de gasificación se realiza cuando la biomasa ha sido secada para reducir su 

humedad hasta menos del 15% (Shahbaz et al., 2020).  
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El contenido de humedad viene expresado como el porcentaje de la masa total de la 

biomasa, convirtiéndolo en un parámetro de control bastante importante cuando se trata 

de fines energéticos ya que tiene una influencia notoria en la eficiencia de conversión y 

poder calorífico (Sánchez et al., 2019). 

2.9.1. Temperatura 

Es uno de los factores más importantes a considerar dentro del proceso de gasificación 

ya que de esta depende la desvolatilización en todas las etapas del proceso y en la 

composición final del gas de síntesis. A medida que aumenta la temperatura, aumenta 

la conversión debido a la presencia de materia volátil que mejora la capacidad de 

conversión de la materia sólida en gas. A medida que se eleva la temperatura, también 

aumenta la formación de productos gaseosos a partir de los sólidos, esto debido a que, 

durante el proceso mejoran los procesos de gasificación de carbón, reformado de 

metano y el agrietamiento de alquitrán. Por el contrario, a temperaturas bajas, se 

produce metano que aumenta el contenido del mismo en el producto (Shahbaz et al., 

2020).  

2.9.1. Presión de trabajo 

La selección de la presión de trabajo se realiza dependiendo de los requerimientos del 

proceso y del equipo. Generalmente se realizan a la presión cercana a los 180 bar. A 

medida que aumenta la presión, la reacción de metanización se ve favorecida, esto hace 

que la formación de alquitrán se de en menores cantidades y la fracción de hidrocarburo 

aromático predomine. La presión también influye sobre los rendimientos de los gases 

obtenidos; esto debido a que afecta la aceleración de la cinética de desplazamiento 

agua/gas, también aumenta el tiempo de residencia de los gases en las partículas 

provocando el craqueo de los alquitranes favoreciendo las reacciones solido/gas. 

La presión demasiado alta disminuye la producción de H2, esto debido a que el equilibrio 

químico se ve desplazada hacia los reactivos (Acevedo Juan & Arenas, 2019). 

2.9.1. Agentes gasificantes  

La elección de gasificante resulta crucial en la composición final de gas de síntesis. El 

agente gasificante puede ser aire, oxígeno, vapor o una mezcla de oxígeno y vapor. El 

uso de alguno de ellos dependerá de la accesibilidad. Se debe tener en consideración 

ciertos aspectos para elegir, por ejemplo, si bien el aire es el agente más conveniente, 

el gas producto presenta contenidos altos de nitrógeno que hacen que el poder calorífico 

disminuya. Lo mismo ocurre con los demás agentes, si bien mejora cierto aspecto, 
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puede ser contradictorio con el objetivo que se busca alcanzar. La elección dependerá 

de requerimientos específicos para un sistema en específico (Xu et al., 2018). 

2.9.1. Catalizador  

El catalizador es una sustancia química que se adiciona a la reacción en pequeñas 

cantidades logrando así aumentar la tasa de equilibrio; sin embargo, la sustancia no 

reacciona químicamente con ninguno de los otros componentes que intervienen en la 

reacción. El catalizador facilita una alternativa al mecanismo de reacción que suele 

implicar un estado de transición con comportamientos energéticos distintos. 

Las reacciones tienen lugar en la superficie del catalizador, ya que es ahí donde se 

genera los sitios activos. Según Ram & Mondal, 2022, el uso de catalizadores influye de 

manera positiva en la producción de hidrógeno gaseoso a la par con la mejora de su 

poder calorífico. Los catalizadores más usados son aquellos a base de Cu, Fe, Ni y Zn. 

Los costos que se generan durante la preparación del catalizador y el inconveniente de 

“ensuciamiento” por la saturación de los poros, suelen ser elevados por lo que hay que 

analizar muchos más factores a fondo para su elección. 

2.9.1. Tiempo de residencia 

El tiempo de residencia es importante para que la reacción se realice completamente. 

La reacción requiere de los tiempos de reacción y de equilibrio. Dicho tiempo de 

residencia empieza con una reacción lenta hasta que después de transcurrido ya por el 

tiempo necesario, la reacción empieza a progresar más deliberadamente. Para lograr 

un mayor control sobre las tasas de flujo de masa, las recomendaciones son trabajar 

con tiempo de residencia mucho más cortos o largos siempre y cuando la relación con 

la temperatura sea equivalente (Shahbaz et al., 2020).  

2.10. Tipos de gasificadores  

El gasificador es el recipiente en donde se lleva a cabo las reacciones durante el proceso 

de gasificación. La elección del tipo de gasificador depende de las propiedades de la 

biomasa, los requerimientos del producto y el agente gasificante a emplear. 

Comúnmente se emplean tres tipos de gasificadores para la biomasa, entre ellos están, 

el gasificador de lecho fijo, gasificador de lecho fluidizado y el gasificador de flujo 

arrastrado (Situmorang et al., 2020). 

2.10.1. Gasificador de lecho fijo 

El gasificador de leche fijo es uno de los más económicos, se ajusta a procesos de 

gasificación a pequeña escala, este tipo de reactores pueden ser de tiro ascendente o 

de tiro descendente. En el caso de los de tiro ascendente, el agente gasificante ingresa 



 
 

 

Jessica Mayli Gaona Cumbicos, Kelly Dayanna Naula Duchi  Página 35  

desde la zona inferior mientras que la biomasa es introducida desde la parte superior, 

es decir, en dirección contracorriente, además posee una alta eficiencia térmica con una 

alta tolerancia en el contenido de humedad de la biomasa de hasta el 60% en base 

húmeda, también acepta un alto rango de tolerancia en el tamaño de la partícula 

pudiendo ser de 5 a 100 mm. Sin embargo, presenta la desventaja de generar más 

alquitrán, debido a que la zona de pirólisis fluye hacia la zona más fría lo que evita 

alcanzar las temperaturas más altas, impidiendo la formación de gases de síntesis 

(Situmorang et al., 2020). 

Por otra parte, el gasificador de tiro descendente es diferente al anterior por la forma en 

la que se introduce el agente gasificante al reactor, pueden ser introducidos desde la 

parte superior o por los lados, y a su vez la biomasa ingresa desde la parte superior, 

teniendo así una misma dirección de corriente. La producción de alquitrán es baja, 

puesto que los productos de desvolatización llegan a la zona de oxidación a elevadas 

temperaturas. No obstante, la transferencia de calor entre la zona caliente y fría es muy 

pobre. Por lo tanto, no acepta biomasas con altos contenidos de humedad, cuyo valor 

de tolerancia debe ser menor al 30%. Los tiempos de residencia deben ser cortos, ya 

que la fuerza de arrastre y la gravedad provoca que la biomasa descienda con mayor 

rapidez. Además, presenta baja eficiencia en la conversión de carbono a comparación 

del tiro ascendente. Durante la reacción existe la posibilidad de darse la formación de 

canalizaciones y formaciones de puente, por ello el tamaño de partícula debe ser 

uniforme y encontrarse entre un rango de 40 a 100 mm (Situmorang et al., 2020). 

 

Figura 6. Gasificadores de lecho fijo (a) Tiro descendente (b) Tiro ascendente. 

Fuente: (Situmorang et al., 2020) 
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2.10.1. Gasificador de lecho fluidizado 

El gasificador de lecho fluidizado presenta una mejor transferencia de calor, mayor 

capacidad de mezcla y distribución de temperatura más uniforme, obteniendo una mayor 

eficacia y conversión de la biomasa. Para procesos de gasificación en este tipo de 

reactores deben generarse temperaturas elevadas, entre 800 a 1000 °C (Situmorang et 

al., 2020). 

Es posible escalar este proceso de manera continua y obtener elevadas eficiencias. El 

gasificador de lecho fluidizado presenta conversiones de hasta el 95% con un tamaño 

de partículas inferior a 20 mm (Situmorang et al., 2020).  

  

Figura 7. Gasificador de lecho fluidizado 

Fuente: (Bermudez et al., 2016).  

2.10.1. Gasificador de flujo arrastrado 

Es ideal para partículas muy finas, que van desde 75 a 100 µm, con temperatura de 

1400 a 1800 °C y elevadas presiones que oscilan entre 20 a 70 bares con la finalidad 

de descomponer totalmente el alquitrán para dar lugar a gas de síntesis. Los tiempos 

de residencia son relativamente cortos, de 1 a 5 s. Por las condiciones de operación y 

biomasa la conversión de carbono puede ser casi del 100%. Sin embargo, sus costos 

de inversión y operación son elevados (Situmorang et al., 2020). 
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Figura 8. Gasificador de flujo arrastrado 

Fuente: (Bermudez et al., 2016).  

2.11. Efecto del catalizador en la reacción  

En las reacciones químicas, la catálisis juega un papel importante en las 

transformaciones químicas, gracias a que modifica la velocidad de una reacción química 

sin que se vea afectada su posición de equilibrio. En los procesos de gasificación el uso 

de catalizadores permite la eliminación del alquitrán en el gas de síntesis, reduce los 

contenidos de metano o cualquier otro gas que no es de interés e incrementa la 

producción de hidrógeno (H2). El tipo de catalizador a usar en la reacción debe ser 

seleccionado en función de su efectividad, resistencia a la desactivación, su facilidad de 

regeneración y costo. Además, pueden ser empleados en la reacción post-gasificación 

e in-situ. Los catalizadores para la gasificación se clasifican acorde a su composición: 

alcalinos, alcalino-térreos y de transición (Serna, 2019).  

2.11.1. Catalizadores de metales alcalinos 

Tienen la función de eliminar el alquitrán para la obtención de un gas de síntesis de 

mejor calidad. Pueden ser adicionados de forma directa en la biomasa a través de un 

mezclado seco o mediante impregnación húmeda. Entre los catalizadores de metales 

alcalinos se encuentran el carbonato de potasio y el carbonato de sodio, considerados 

como catalizadores primarios, es decir, en reacciones in-situ. Este tipo de catalizadores 

son más activos en la gasificación, debido a que la actividad de los metales alcalino es 

mejor a medida que aumenta su peso atómico. Además, su actividad catalítica está 

relacionada con la capacidad de donar electrones, en base a esto el orden de la 

actividad catalítica es de K > N > Li (Serna, 2019). 
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2.11.1. Catalizadores de metales alcalino-térreos 

Los catalizadores de metales alcalino-térreos pueden ser utilizados como catalizadores 

primarios o secundarios, siendo este último introducido a un reactor aguas abajo. 

Generalmente suele usarse la dolomita por su eficacia en la eliminación de alquitrán y 

al ser económicamente rentable, ya que no hay necesidad de regenerarla gracias a su 

fácil disponibilidad y abundancia. Los catalizadores a base de calcio mejoran la 

conversión agua-gas y reformado de metano con vapor, provocan la ruptura de 

alquitrán, absorbe otras especies como el azufre, disminuyendo así la liberación de 

ácido sulfhídrico (H2S) en el gas de síntesis. En biomasas con altas concentraciones de 

nitrógeno, genera la formación de N2 inerte para la reacción (Serna, 2019). 

2.11.1. Catalizadores de metales de transición 

Entre los catalizadores de metales de transición se encuentra el níquel, empleado aguas 

abajo del catalizador, es decir, en un reactor secundario a una temperatura de 740 °C, 

el mismo que genera un aumento en el contenido de hidrógeno y monóxido de carbono 

en el gas de síntesis, provocando la disminución de hidrocarburos y metano. El níquel 

evita la liberación de compuestos de azufre durante la fase de vapor. Cuando la reacción 

es dada a bajas temperaturas, la metanización se ve favorecida termodinámicamente. 

Además, el níquel presenta la desventaja al momento de su desactivación en la 

superficie de carbono, por lo que es necesario combinarlo con algún soporte para 

mejorar su rendimiento (Serna, 2019).   

2.12. Simulación numérica 

En los últimos años la simulación numérica se ha convertido en una herramienta 

fundamental en diseños de productos, predicción de procesos técnicos e industriales, 

así como su optimización, de esta manera resulta una alternativa barata en la 

investigación de productos y procesos sobre todo cuando la experimentación es muy 

compleja, peligrosa o representa costos elevados (Laín Beatove, 2014). La simulación 

numérica o simulación digital emplea herramientas matemáticas para modelar, simular 

o predecir el comportamiento de fenómenos mecánicos, estructurales, termodinámicos, 

productos y procesos de la ingeniería y de las ciencias aplicadas. 

La utilización de simulaciones numéricas en el estudio de ecuaciones se requiere 

conocer sobre los métodos numéricos, algoritmos que se pueden emplear y de los 

procesos fundamentales que van incluidos en la simulación. Por lo que, para estudiar 

un problema es importante realizar una planificación del modelo matemático y 

algoritmos determinados para la resolución de dicho modelo (Millán et al., 2011). 
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2.12.1. Solución analítica 

La solución analítica permite una mejor compresión sobre el comportamiento de ciertos 

fenómenos puesto que puede ser empleada en todo instante de tiempo. En el caso de 

ecuaciones diferenciales, la solución analítica se basa en la resolución a través de 

expresiones matemáticas explicitas mediante distintas técnicas, tales como la 

separación de variables, transformadas de Laplace, el uso de factores integrantes, etc. 

Por lo que, al sustituir valores de una variable independiente se logra obtener los valores 

de la función incógnita (Ortiz Moctezuma, 2015). 

2.12.1. Solución numérica 

Se basa en la resolución numérica de ecuaciones diferenciales, empleando métodos 

numéricos a través de una computadora digital. Para ello, es posible emplear un 

lenguaje de programación que permitan el uso de operaciones matemáticas numéricas 

o un software especializado, con interfaces diseñadas para un sistema en específico 

(Ortiz Moctezuma, 2015).  

2.13. Etapas de la simulación 

2.13.1. Pre-proceso 

Es la etapa en la que se definen los objetivos de la simulación, dichos objetivos 

comprenden desde la definición del sistema, la evaluación de la disponibilidad de datos, 

es decir, las condiciones de contorno y el mallado (Laín & García, 2015). Dentro de esta 

etapa también se encuentra la asignación de materiales, propiedades y 

acondicionamiento previo como la evaluación de posibles simplificaciones para 

garantizar buenas aproximaciones de resultados (Antonio et al., 2017). 

2.13.1.1. Modelo geométrico 

El modelo geométrico es la representación gráfica del sistema en el que se trabaja, la 

construcción de él facilita la caracterización del sistema sobre el que se trabaja, facilita 

la medición de ciertos parámetros y características de ciertas partes. Estos modelos se 

construyen suficientemente detallados o representaciones generales; sobre él se 

colocarán las condiciones de contorno, esto se realiza construyendo la geometría con 

medidas reales en 3D y en un software especializado (Espinilla, 2019). 

2.13.1.2. Condiciones de contorno 

También conocidos como valores de contorno, son aquellos que se usan para definir 

adecuadamente el problema sobre el que se requiera trabajar. Pequeños cambios en 

ellos pueden influir también de manera significativa en la solución (Sancho Ávila, 2018). 

Según Cabrera et al., (2021), una condición de contorno, es la información que se tiene 
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de la solución en la frontera de una región que está definida, es decir, la información 

que se encuentra en los límites del sistema que se está modelando a través del software. 

2.13.1.3. Mallado 

Una vez terminada la geometría e identificadas las condiciones de contorno con las que 

se cuenta, la geometría de subdivide en pequeñas regiones que en conjunto forman lo 

que se conoce con el nombre de malla (Mesh). La malla está formada por nodos y aristas 

que en conjunto y unidos forman una superficie.  

Por lo general, el software en el que se trabaja, divide de manera automática la 

geometría en múltiples y pequeñas áreas lo más regulares posibles. El resultado es una 

malla regular hexaédrica, aunque también puede ser tetraédrica, piramidal o híbrida. 

Existen diferentes tipos de mallas dependiendo la forma y distribución de cada elemento 

(Lozada et al., 2018). Si bien el mallado por defecto, la red que se forma no sigue 

ninguna dirección específica, exige menores recursos computacionales y menos tiempo 

de resolución de la simulación (Martínez, 2019). 

2.13.1. Proceso 

También conocida como etapa de cálculo, consiste en evaluar la convergencia de la 

solución. Para ello, previamente se trabaja en el desarrollo del modelo matemático 

cuyas condiciones se ajusten a todo el proceso (Cabrera et al., 2021). 

2.13.1. Post-Proceso 

Consiste en la etapa de análisis de resultados y validación de datos, aquí se obtienen 

resultados específicos. Los valores y soluciones obtenidas se comparan con otros ya 

existentes. Estos análisis dependen del tipo de sistema con el que se trabaje y a la 

solución hacia la que se apunte. Hace uso y extrae; las tablas, animaciones, tendencias 

extraídas, sirven como soporte para dicho análisis (Parrilla & García, 2019). 

2.14. Solución numérica de las ecuaciones de Navier-Stokes 

Las ecuaciones de Navier Stokes son un conjunto de ecuaciones que permiten describir 

los procesos de impulso, calor, movimiento de un fluido y transferencia de masas. 

Además, existen otros procesos tales como la combustión que pueden resolverse con 

la ayuda de las ecuaciones de Navier Stokes (Carrera, 2019). 

Las ecuaciones de Navier-Stokes están constituidas por un sistema de ecuaciones en 

derivadas parciales no lineales, las mismas que describen el movimiento de un fluido y 

de cualquier fenómeno en el que intervenga algún fluido. Dichas ecuaciones son 

obtenidas a partir de principios de la conservación de la mecánica y termodinámica a un 
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volumen de fluido. Para la obtención de las ecuaciones en su forma diferencial, se 

realizan consideraciones físico matemáticas, como el análisis y relación de los esfuerzos 

tangenciales y el gradiente de velocidad, con la finalidad de obtener resultados o la 

solución a un problema (Romero et al., 2019). 

El programa ANSYS-CFX se basa en la resolución de las ecuaciones de Navier Stokes 

en función del fluido y de otros términos adicionales sobre un modelo o diseño 

tridimensional asistido por computadora. Esta metodología permite colocar condiciones 

de contorno para obtener información de todas las variables en gran cantidad de puntos 

del espacio, lo cual es complicado de llevar a cabo en modelos físicos (Carrera, 2019). 

De forma generalizada la ecuación de Navier Stokes queda de la siguiente manera: 

𝜌
𝜕𝑢⃗⃗ 

𝜕𝑡
+ 𝜌(𝑢⃗ ∙ 𝛻)𝑢⃗ = −𝛻𝑃 + 𝜌𝑔 + 𝜇𝛻2𝑢⃗     (1) 

Donde 𝜌  es la densidad, 
𝜕𝑢⃗⃗ 

𝜕𝑡
 es la derivada de la velocidad en el tiempo, 𝑢⃗  es la 

velocidad,  ∇𝑃 es el gradiente de la presión y 𝜇 es la viscosidad. Por lo tanto, la ecuación 

está dada por 𝜌
𝜕𝑢⃗⃗ 

𝜕𝑡
 como la derivada total, el gradiente de presión −∇𝑃, las fuerzas 

externas que actúan sobre el fluido 𝜌𝑔 , la difusión 𝜇∇2𝑢⃗ . 
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CAPITULO 3: MODELACIÓN Y SIMULACIÓN 

3.1. Desarrollo del modelo cinético  

El modelo cinético de la reacción de gasificación de biomasa, describe los mecanismos 

de todo el sistema a través de procesos de adsorción, desorción durante la activación 

de los reactivos, reacción superficial y desorción de los productos, mediante el 

mecanismo de Langmuir-Hinshelwood, con la finalidad de considerar los componentes 

que reaccionan a lo largo del tiempo (Adamu & Hossain, 2018). 

Durante el proceso de gasificación, la macromolécula de biomasa se transforma en una 

serie de productos, entre los principales se encuentran el hidrógeno H2, monóxido de 

carbono CO, dióxido de carbono CO2, metano CH4, agua H2O, y en menores cantidades 

coque y alquitranes (Adamu & Hossain, 2018a). Para representar dicha reacción, se 

hace uso de la siguiente fórmula general: 

𝐶𝑥𝐻𝑦𝑂𝑧 + 𝑛𝐻2𝑂
∆
→ 𝑎1𝐻2 + 𝑎2𝐶𝑂 + 𝑎3𝐶𝑂2 + 𝑎4𝐻2𝑂+𝑎5𝐶𝐻4+𝑎6𝐶 + 𝑎𝑙𝑞𝑢𝑖𝑡𝑟𝑎𝑛𝑒𝑠 (2) 

En la ecuación (2) las cantidades de cada uno de los productos dependen de las 

condiciones de operación durante la reacción, tipo de biomasa, actividad y selectividad 

del catalizador. Los productos gaseosos a lo largo de la reacción vuelven a reaccionar 

para dar lugar a la distribución final del gas de síntesis (Adamu & Hossain, 2018). 

La gasificación de biomasa conlleva una serie de reacciones químicas que tienen lugar 

mediante el secado, la descomposición de las partículas, oxidación y reducción. La 

biomasa puede representarse como C, en la tabla 3, se muestran las principales 

reacciones que se llevan a cabo durante el proceso. 

 Tabla 3. Reacciones que intervienen en el proceso de gasificación de biomasa 

Reacción Ecuación 
Entalpía de 

reacción (kJ/mol) 

Cambio de gas de agua 𝐶𝑂 + 𝐻2𝑂 ↔ 𝐻2 + 𝐶𝑂2           (3) ∆𝐻° = −41.2 

Reformado de metano con vapor 𝐶𝐻4 + 𝐻2𝑂 ↔ 𝐶𝑂 + 3𝐻2         (4) 
 

∆𝐻° =  206.0 

Reformado en seco de metano 𝐶𝐻4 + 𝐶𝑂2 ↔ 2𝐶𝑂 + 2𝐻2        (5) ∆𝐻° =  247.0 

Gasificación de coque 𝐶 + 𝐻2𝑂 ↔ 𝐶𝑂 + 𝐻2               (6) 
 

∆𝐻° =  131.3 

Reacción inversa de Boudouard 𝐶 + 𝐶𝑂2 ↔ 2𝐶𝑂                      (7) ∆𝐻° =  172.5 

Reacción de hidrogenación 𝐶 + 2𝐻2 ↔ 𝐶𝐻4                      (8) ∆𝐻° = −74.5 

Fuente: (Adamu & Hossain, 2018) 

De acuerdo a Adamu & Hossain (2018) el modelo de Lagmuir-Hinshelwood puede ser 

aplicado para modelar una reacción de gasificación catalítica de biomasa, siempre y 
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cuando se establezcan suposiciones y aproximaciones adecuadas. Por lo tanto, para el 

modelo cinético se realizan las siguientes suposiciones: 

I. La biomasa se convierte en CO, CO2, H2 y CH4, con trazas de coque y alquitrán. 

II. El CO, CO2, H2, CH4 y H2O, son adsorbidos en la superficie del catalizador, las 

cuales reaccionan hasta que se desorben y para formar parte del producto. 

III. Las reacciones dominantes en la reacción son el cambio de agua-gas (WGS), el 

reformado seco de metano (DRM) y las reacciones de reformado de metano con 

vapor (SRM). 

Para que la suposición (i) sea verdadera durante la reacción, la presión del reactor no 

debe superar los 57 psi y los principales productos generados deben ser el CO, CO2, 

H2, CH4. 

En el caso de la suposición (iii), el valor de las energías de activación de la reacción de 

Bourdouard y metanización deben ser mayores a las SRM, WGS, y reformado de seco 

de metano inversa (RDRM). 

3.1.1. Reformado de metano con vapor 

De acuerdo a la investigación realizada por Adamu & Hossain (2018), el reformado de 

metano con vapor (SRM) se representa con la siguiente reacción general: 

𝐶𝐻4 + 𝐻2𝑂 ↔ 𝐶𝑂 + 3𝐻2         (4) 

El metano presente en la reacción proviene de las reacciones anteriores entre la 

biomasa C, agua H2O e hidrógeno H2, como se puede observar en las ecuaciones 6 y 

8 de la tabla 3. Por lo tanto, el metano formado de dichas reacciones continúa 

reaccionando con el agente gasificante presente en el sistema, es decir, el vapor de 

agua. 

El mecanismo de adsorción/reacción/desorción se da de la siguiente manera: 

1. Adsorción de metano en el sitio activo del catalizador: 

𝐶𝐻4 + 𝑆 

𝑘1

← ⃗⃗⃗⃗  
𝑘2

𝐶𝐻4 − 𝑆     (9) 

2. Adsorción de vapor en el sitio activo del catalizador: 

𝐻2𝑂 + 𝑆 

𝑘3

←⃗⃗⃗ 
𝑘4

 𝐻2𝑂 − 𝑆     (10) 

3. Reacción superficial en el sitio activo del catalizador: 
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𝐶𝐻4 − 𝑆 + 𝐻2𝑂 − 𝑆 + 2𝑆 

𝑘5

←⃗⃗⃗ 
𝑘6

 𝐶𝑂 − 𝑆 + 3𝐻2 − 𝑆   (11) 

4. Desorción de CO en la superficie del catalizador: 

𝐶𝑂 − 𝑆 

𝑘7

←⃗⃗⃗ 
𝑘8

 𝐶𝑂 + 𝑆     (12) 

5. Desorción de H2 de la superficie del catalizador: 

𝐻2 − 𝑆 

𝑘9

←⃗⃗⃗ 
𝑘10

 𝐻2 + 𝑆     (13) 

Considerando un pseudo-estado estacionario se plantea la siguiente ecuación para 

describir el mecanismo de adsorción: 

𝑟𝑆𝑅𝑀 =
𝑘𝑆𝑅𝑀𝑃𝐶𝐻4𝑃𝐻2𝑂

(1+𝐾𝐻2𝑃𝐻2+𝐾𝐻2𝑂𝑃𝐻2𝑂+𝐾𝐶𝑂𝑃𝐶𝑂+𝐾𝐶𝑂2𝑃𝐶𝑂2+𝐾𝐶𝐻4𝑃𝐶𝐻4)4
× (1 −

𝑃𝐶𝑂𝑃𝐻2
3

𝐾𝑆𝑅𝑀𝑃𝐶𝐻4𝑃𝐻2𝑂
) (14) 

Donde el valor de 𝐾𝑆𝑅𝑀 es la constante de velocidad de equilibrio de la reacción SRM, 

𝑘𝑆𝑅𝑀  es la constante de velocidad de reacción concentrada para SRM, 

𝐾𝐻2,𝐻2𝑂,𝐶𝑂,𝐶𝑂2,𝐶𝐻4 es la constante de velocidad de adsorción de cada componente y 

𝑃𝐻2,𝐻2𝑂,𝐶𝑂,𝐶𝑂2,𝐶𝐻4 es la presión para cada componente. 

3.1.2. Reacción de cambio de gas de agua 

Según, Adamu & Hossain (2018), para el cambio total de gas de agua se representa 

con la reacción general:  

𝐶𝑂 + 𝐻2𝑂 ↔ 𝐻2 + 𝐶𝑂2           (3) 

El monóxido de carbono CO, proviene de las reacciones de la biomasa C, el agente 

gasificante H2O y dióxido de carbono CO2, como se muestran en la ecuación 6 y 7 de la 

tabla 3. Además, existen otras fuentes que aportan más cantidades de CO al sistema, 

como es el caso de las reacciones de las ecuaciones 4 y 5. 

Para el proceso de adsorción/reacción/desorción se describe con el siguiente 

mecanismo de reacciones: 

1. Adsorción de CO en el sitio activo del catalizador: 

𝐶𝑂 + 𝑆 

𝑘1

←⃗⃗⃗ 
𝑘2

 𝐶𝑂 − 𝑆     (15) 

2. Adsorción de vapor en el sitio activo del catalizador: 
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𝐻2𝑂 + 𝑆 

𝑘3

←⃗⃗⃗ 
𝑘4

 𝐻2𝑂 − 𝑆     (16) 

3. Reacción superficial en el sitio activo del catalizador: 

𝐶𝑂 − 𝑆 + 𝐻2𝑂 − 𝑆 

𝑘5

←⃗⃗⃗ 
𝑘6

 𝐶𝑂2 − 𝑆 + 𝐻2 − 𝑆   (17) 

4. Desorción de CO2 de la superficie del catalizador: 

𝐶𝑂2 − 𝑆 

𝑘7

←⃗⃗⃗ 
𝑘8

 𝐶𝑂2 + 𝑆     (18) 

5. Desorción de H2 de la superficie del catalizador: 

𝐻2 − 𝑆 

𝑘9

←⃗⃗⃗ 
𝑘10

 𝐻2 + 𝑆     (19) 

Considerando un pseudo-estado estacionario se plantea la siguiente ecuación para 

describir el mecanismo de adsorción: 

𝑟𝑊𝐺𝑆 =
𝑘𝑊𝐺𝑆𝑃𝐶𝑂𝑃𝐻2𝑂

(1+𝐾𝐻2𝑃𝐻2+𝐾𝐻2𝑂𝑃𝐻2𝑂+𝐾𝐶𝑂𝑃𝐶𝑂+𝐾𝐶𝑂2𝑃𝐶𝑂2+𝐾𝐶𝐻4𝑃𝐶𝐻4)2
× (1 −

𝑃𝐶𝑂2𝑃𝐻2

𝐾𝑊𝐺𝑆𝑃𝐶𝑂𝑃𝐻2𝑂
) (20) 

Donde el valor de 𝐾𝑊𝐺𝑆 es la constante de velocidad de equilibrio de la reacción WGS, 

𝑘𝑊𝐺𝑆  es la constante de velocidad de reacción concentrada para WGS, 

𝐾𝐻2,𝐻2𝑂,𝐶𝑂,𝐶𝑂2,𝐶𝐻4 es la constante de velocidad de adsorción de cada componente y 

𝑃𝐻2,𝐻2𝑂,𝐶𝑂,𝐶𝑂2,𝐶𝐻4 es la presión para cada componente. 

3.1.3. Reformado Inverso en seco de metano 

De acuerdo a Adamu & Hossain (2018), la reacción general para el reformado inverso 

en seco del metano:  

𝐶𝐻4 + 𝐶𝑂2 ↔ 2𝐶𝑂 + 2𝐻2        (5) 

De la misma manera que en las reacciones anteriores SRM y WGS, las fuentes de los 

reactivos en la reacción RDRM, provienen de los productos generados de las reacciones 

presentadas en la tabla 3. 

Para el proceso de adsorción/reacción/desorción se describe con el siguiente 

mecanismo de reacciones: 

1. Adsorción de CO en el sitio activo del catalizador: 

𝐶𝑂 + 𝑆 

𝑘1

←⃗⃗⃗ 
𝑘2

 𝐶𝑂 − 𝑆     (21) 
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2. Adsorción de vapor en el sitio activo del catalizador: 

𝐻2 + 𝑆 

𝑘3

←⃗⃗⃗ 
𝑘4

 𝐻2 − 𝑆     (22) 

3. Reacción superficial en el sitio activo del catalizador: 

2𝐶𝑂 − 𝑆 + 2𝐻2 − 𝑆 

𝑘5

←⃗⃗⃗ 
𝑘6

 𝐶𝑂2 − 𝑆 + 𝐶𝐻4 − 𝑆 + 2𝑆   (23) 

4. Desorción de CO2 de la superficie del catalizador: 

𝐶𝑂2 − 𝑆 

𝑘7

←⃗⃗⃗ 
𝑘8

 𝐶𝑂2 + 𝑆     (24) 

5. Desorción de CH4 de la superficie del catalizador: 

𝐶𝐻4 − 𝑆 

𝑘9

←⃗⃗⃗ 
𝑘10

 𝐶𝐻4 + 𝑆     (25) 

Considerando un pseudo-estado estacionario se plantea la siguiente ecuación para 

describir el mecanismo de adsorción: 

𝑟𝑅𝐷𝑅𝑀 =
𝑘𝑅𝐷𝑅𝑀𝑃𝐶𝑂

2𝑃𝐻2
2

(1+𝐾𝐻2𝑃𝐻2+𝐾𝐻2𝑂𝑃𝐻2𝑂+𝐾𝐶𝑂𝑃𝐶𝑂+𝐾𝐶𝑂2𝑃𝐶𝑂2+𝐾𝐶𝐻4𝑃𝐶𝐻4)4
× (1 −

𝑃𝐶𝑂2𝑃𝐶𝐻4

𝐾𝑅𝐷𝑅𝑀𝑃𝐶𝑂
2𝑃𝐻2

2) (26) 

Donde el valor de 𝐾𝑅𝐷𝑅𝑀  es la constante de velocidad de equilibrio para la reacción 

RDRM, 𝑘𝐾𝐷𝑅𝑀  es la constante de velocidad de reacción concentrada para RDRM, 

𝐾𝐻2,𝐻2𝑂,𝐶𝑂,𝐶𝑂2,𝐶𝐻4 es la constante de velocidad de adsorción de cada componente y 

𝑃𝐻2,𝐻2𝑂,𝐶𝑂,𝐶𝑂2,𝐶𝐻4 es la presión para cada componente. 

3.1.4. Ecuaciones para la determinación de las constantes de velocidad y 

constantes de velocidad de equilibrio 
Las constantes de velocidad de reacción pueden ser obtenidas mediante la ecuación de 

Arrhenius, como se indica en la ecuación (27). 

𝑘𝑗 = 𝑘𝑗
0 𝑒𝑥𝑝 [−

𝐸𝑎

𝑅𝑇
(
1

𝑇
−

1

𝑇0
)]    (27) 

Donde 𝑘𝑗  corresponde a la constante de velocidad para la j-ésima reacción, 𝑘𝑗
0 

corresponde al factor pre-exponencial para la j-ésima reacción, 𝐸𝑎  es la energía de 

activación para la j-ésima reacción, 𝑇  es la temperatura de reacción, 𝑇0  es la 

temperatura estándar y 𝑅 es la constante de los gases ideales. 

𝐾𝑖 = 𝐾𝑖
0 𝑒𝑥𝑝 [−

∆𝐻𝑖
𝑎𝑑𝑠

𝑅𝑇
(
1

𝑇
−

1

𝑇0
)]    (28) 
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Donde 𝑘𝑖 corresponde a la constante de velocidad de adsorción del componente i, 𝑘𝑖
0 

corresponde al factor pre-exponencial para el componente i, ∆𝐻𝑖
𝑎𝑑𝑠  es el calor de 

adsorción para el componente i del catalizador, 𝑇 es la temperatura de reacción y 𝑇0 es 

la temperatura estándar y 𝑅 es la constante de los gases ideales. 

3.1.5. Modelo cinético para la evolución del número de moles con respecto al 

tiempo 

𝐶𝐻4 + 𝐻2𝑂 ↔ 𝐶𝑂 + 3𝐻2         (4) 

𝐶𝑂 + 𝐻2𝑂 ↔ 𝐻2 + 𝐶𝑂2           (3) 

𝐶𝐻4 + 𝐶𝑂2 ↔ 2𝐶𝑂 + 2𝐻2        (5) 

Una vez definidas las ecuaciones cinéticas para la determinación de las velocidades de 

reacción 𝑟𝑆𝑅𝑀 , 𝑟𝑊𝐺𝑆  y 𝑟𝑅𝐷𝑅𝑀  se estableció el modelo cinético que rige al proceso de 

gasificación con la finalidad de observar la evolución de cada componente a través del 

tiempo, para ello se empleó la ecuación de tasa aditiva para especies componentes de 

las reacciones SRM, WGS y RDRM (Adamu & Hossain, 2018). 

𝑅𝑐 = ∑ 𝑣𝑖,𝑗𝑟𝑗
𝑛𝑖
𝑗       (29) 

Donde 𝑣𝑖,𝑗 es el coeficiente estequiométrico del componente i en la j-ésima reacción. 

Por lo tanto, en base a las ecuaciones presentadas con anterioridad, se desarrollaron 

las ecuaciones cinéticas para cada componente, las mismas que quedan de la siguiente 

manera: 

∀

𝑅𝑇

𝑑𝑃𝐻2

𝑑𝑡
=

𝑑𝑛𝐻2

𝑑𝑡
= 𝑅𝐻2

= (𝑟𝑊𝐺𝑆 + 3𝑟𝑆𝑅𝑀 − 2𝑟𝑅𝐷𝑅𝑀) ∗ 𝑚𝑐𝑎𝑡  (30) 

∀

𝑅𝑇

𝑑𝑃𝐶𝑂

𝑑𝑡
=

𝑑𝑛𝐶𝑂

𝑑𝑡
= 𝑅𝐶𝑂 = (−𝑟𝑊𝐺𝑆 + 𝑟𝑆𝑅𝑀 − 2𝑟𝑅𝐷𝑅𝑀) ∗ 𝑚𝑐𝑎𝑡  (31) 

∀

𝑅𝑇

𝑑𝑃𝐶𝑂2

𝑑𝑡
=

𝑑𝑛𝐶𝑂2

𝑑𝑡
= 𝑅𝐶𝑂2

= (𝑟𝑊𝐺𝑆 + 𝑟𝑅𝐷𝑅𝑀) ∗ 𝑚𝑐𝑎𝑡   (32) 

∀

𝑅𝑇

𝑑𝑃𝐶𝐻4

𝑑𝑡
=

𝑑𝑛𝐶𝐻4

𝑑𝑡
= 𝑅𝐶𝐻4

= (−𝑟𝑆𝑅𝑀 + 𝑟𝑅𝐷𝑅𝑀) ∗ 𝑚𝑐𝑎𝑡   (33) 

∀

𝑅𝑇

𝑑𝑃𝐻2𝑂

𝑑𝑡
=

𝑑𝑛𝐻2𝑂

𝑑𝑡
= 𝑅𝐻2𝑂 = (−𝑟𝑊𝐺𝑆 − 𝑟𝑅𝐷𝑅𝑀) ∗ 𝑚𝑐𝑎𝑡   (34) 

 

Donde ∀ es el volumen, 𝑅 es la constante de los gases ideales, 𝑇 es la temperatura de 

reacción,  
𝑑𝑛𝑖

𝑑𝑡
 corresponde a la evolución de los moles del componente i con respecto al 

tiempo durante la reacción de gasificación y 𝑚𝑐𝑎𝑡 corresponde a la masa del catalizador. 
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3.1.5.1. Determinación del número de moles de cada componente 

Para la determinación del número de moles de cada componente se empleó la siguiente 

fórmula general en base a la ecuación (2), adaptada para el presente estudio. 

𝐶6𝐻12𝑂6 + 𝐻2𝑂 → 𝐶𝐻4 + 3𝐻2 + 𝐶𝑂2 + 2𝐻2𝑂 + 𝐶   (35) 

A partir de la ecuación general, se tomó como referencia una solución de 1.5 mL con 

una concentración del 15% de glucosa en agua de acuerdo a la investigación realizada 

por Adamu & Hossain (2018), con lo cual se determinó el número de moles y masa de 

la glucosa y el agua con las siguientes ecuaciones. 

𝑚 = 𝑉 ∗ 𝜌     (36) 

Donde 𝑚 es la masa del reactivo, 𝑉 es la masa del reactivo y 𝜌 es la densidad del 

reactivo. 

𝑛 =
𝑚

𝑃𝑀
      (37) 

Donde 𝑛 es el número de moles y 𝑃𝑀 es el peso molecular. 

Mediante la fórmula general, se identificó el reactivo limitante con la finalidad de obtener 

el número de moles y masa de cada uno de los productos.  

3.1.6. Modelo cinético para la evolución del flujo molar con respecto al eje axial 

Z 

Partiendo de las reacciones SRM, WGS, DRDRM, se obtuvo las ecuaciones cinéticas 

de la variación del número de moles con respecto al eje Z. Sin embargo, con anterioridad 

se partió desde la variación del flujo molar con respecto al volumen del reactor (
𝑑𝑛̇𝑖

𝑑∀
). Por 

lo tanto, se desarrollaron las ecuaciones cinéticas para cada componente de la siguiente 

manera: 

𝑑𝑛̇𝐻2

𝑑∀
= 𝑅𝐻2

= (𝑟𝑊𝐺𝑆 + 3𝑟𝑆𝑅𝑀 − 2𝑟𝑅𝐷𝑅𝑀)   (38) 

𝑑𝑛̇𝐶𝑂

𝑑∀
= 𝑅𝐶𝑂 = (−𝑟𝑊𝐺𝑆 + 𝑟𝑆𝑅𝑀 − 2𝑟𝑅𝐷𝑅𝑀)   (39) 

𝑑𝑛̇𝐶𝑂2

𝑑∀
= 𝑅𝐶𝑂2

= (𝑟𝑊𝐺𝑆 + 𝑟𝑅𝐷𝑅𝑀)    (40) 

𝑑𝑛̇𝐶𝐻4

𝑑∀
= 𝑅𝐶𝐻4

= (−𝑟𝑆𝑅𝑀 + 𝑟𝑅𝐷𝑅𝑀)    (41) 

𝑑𝑛̇𝐻2𝑂

𝑑∀
= 𝑅𝐻2𝑂 = (−𝑟𝑊𝐺𝑆 − 𝑟𝑅𝐷𝑅𝑀)    (42) 

Con la finalidad de realizar el cambio con respecto al eje axial Z, se define a 
𝑑𝑛̇𝑖

𝑑∀
 con la 

ecuación (43). 



 
 

 

Jessica Mayli Gaona Cumbicos, Kelly Dayanna Naula Duchi  Página 49  

 
𝑑𝑛̇

𝑑∀
=

𝑑𝑛̇

𝑑𝑧
∙
𝑑𝑧

𝑑∀
      (43) 

Donde: 

 
𝑑𝑧

𝑑∀
=

1

𝐴𝐶(1−𝜀)
      (44) 

Reemplazando la ecuación (44) en la ecuación (43) se obtiene: 

 
𝑑𝑛̇

𝑑∀
=

𝑑𝑛̇

𝑑𝑧
∙

1

𝐴𝐶(1−𝜀)
     (45) 

Despejando 𝑑∀: 

𝐴𝐶(1 − 𝜀)
𝑑𝑛̇

𝑑∀
=

𝑑𝑛̇

𝑑𝑧
     (46) 

𝑑∀= 𝐴𝑐(1 − 𝜀)𝑑𝑧     (47) 

Por lo tanto, reemplazando el valor 𝑑∀  en las ecuaciones cinéticas, se obtuvo la 

evolución del flujo molar del componente i con respecto a z (
𝑑𝑛̇𝑖

𝑑∀
). 

𝑑𝑛̇𝐻2

𝑑𝑧
= 𝑅𝐻2

= (𝑟𝑊𝐺𝑆 + 3𝑟𝑆𝑅𝑀 − 2𝑟𝑅𝐷𝑅𝑀) ∗ 𝐴𝑐(1 − 𝜀)   (48) 

𝑑𝑛̇𝐶𝑂

𝑑𝑧
= 𝑅𝐶𝑂 = (−𝑟𝑊𝐺𝑆 + 𝑟𝑆𝑅𝑀 − 2𝑟𝑅𝐷𝑅𝑀) ∗ 𝐴𝑐(1 − 𝜀)   (49) 

𝑑𝑛̇𝐶𝑂2

𝑑𝑧
= 𝑅𝐶𝑂2

= (𝑟𝑊𝐺𝑆 + 𝑟𝑅𝐷𝑅𝑀) ∗ 𝐴𝑐(1 − 𝜀)    (50) 

𝑑𝑛̇𝐶𝐻4

𝑑𝑧
= 𝑅𝐶𝐻4

= (−𝑟𝑆𝑅𝑀 + 𝑟𝑅𝐷𝑅𝑀) ∗ 𝐴𝑐(1 − 𝜀)    (51) 

𝑑𝑛̇𝐻2𝑂

𝑑𝑧
= 𝑅𝐻2𝑂 = (−𝑟𝑊𝐺𝑆 − 𝑟𝑅𝐷𝑅𝑀) ∗ 𝐴𝑐(1 − 𝜀)   (52) 

3.1.6.1. Determinación del flujo molar de cada componente 

Una vez obtenidos el número de moles y masa de cada uno de los productos se 

determinó el flujo molar considerando un tiempo de reacción de 25 segundos de acuerdo 

a Adamu & Hossain (2018). Para ello se aplicó la ecuación (53): 

𝑛̇ =
𝑚𝑜𝑙𝑒𝑠

𝑡
     (53) 

Donde 𝑛̇ es el flujo molar de cada componente, 𝑚 es a masa de cada componente y 𝑡 

es el tiempo de reacción. 

3.1.6.2. Determinación del área transversal y porosidad del lecho catalítico 

El área transversal se determinó mediante las especificaciones del diseño del reactor 

realizado por Tacuri (2020), el cual posee un diámetro interno de 3 cm. Por lo tanto, se 

aplicó la ecuación (54). 

𝐴𝑐 =
𝜋𝐷2

4
     (54) 
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Donde 𝐴𝑐 es el área transversal, 𝐷 es el diámetro interno del reactor. 

La porosidad correspondiente al lecho catalítico, se determinó mediante el diseño del 

lecho con esferas de 1 mm empaquetadas en un diámetro de 3 cm a una altura de 10 

mm. Las ecuaciones empleadas para la determinación de la porosidad son las 

siguientes: 

𝑉𝑙𝑒𝑐ℎ𝑜 = 𝜋𝑟2ℎ     (55) 

Donde 𝑉𝑙𝑒𝑐ℎ𝑜  es el volumen del lecho, 𝑟 y ℎ corresponden al radio y altura del lecho 

respectivamente. 

𝑉𝑇𝑒𝑠𝑓 =
4

3
𝜋𝑟𝑒𝑠𝑓

3 ∗ 𝑁°     (56) 

Donde 𝑉𝑇𝑒𝑠𝑓 es el volumen total de las esferas y 𝑟𝑒𝑠𝑓 es el radio de las esferas, 𝑁° es el 

número de esferas empaquetadas en el lecho catalítico. 

Por lo tanto, la porosidad (𝜀) se calculó con la ecuación (57). 

𝜀 =
𝑉𝑙𝑒𝑐ℎ𝑜−𝑉𝑇𝑒𝑠𝑓

𝑉𝑙𝑒𝑐ℎ𝑜
      (57) 

De acuerdo al estudio realizado por Adamu & Hossain (2018), los parámetros cinéticos 

empleados en las ecuaciones se establecen en la tabla 4. 

Tabla 4. Parámetros cinéticos para el modelo 

Parámetros Unidad Valor 

𝐾𝑆𝑅𝑀  -  0.0799 

𝐾𝑊𝐺𝑆  - 3.640 

𝐾𝑅𝐷𝑅𝑀  - 45.500 

𝑘𝑆𝑅𝑀
0   (mmol/gcat.s.bar2) 4.13e-2 

𝑘𝑊𝐺𝑆
0   (mmol/gcat.s.bar2) 7.76e-2 

𝑘𝑅𝐷𝑅𝑀
0   (mmol/gcat.s.bar2) 3.57e-2 

𝐸𝑆𝑅𝑀   (kJ/mol) 4.23 

𝐸𝑊𝐺𝑆  (kJ/mol) 20.02 

𝐸𝑅𝐷𝑅𝑀  (kJ/mol) 7.90 

∆𝐻𝐻2 
𝑎𝑑𝑠  (kJ/mol) 0.13 

∆𝐻𝐶𝑂
𝑎𝑑𝑠  (kJ/mol) 0.14 

∆𝐻𝐶𝑂2

𝑎𝑑𝑠  (kJ/mol) 2.06e-9 

∆𝐻𝐶𝐻4

𝑎𝑑𝑠  (kJ/mol) 0.050 

∆𝐻𝐻2𝑂
𝑎𝑑𝑠    (kJ/mol) 0.14 
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𝐾𝐻2 
0   (bar-1) 1.11e-5 

𝐾𝐶𝑂
0   (bar-1) 1.10e-5 

𝐾𝐶𝑂2

0   (bar-1) 1.73e-5 

𝐾𝐶𝐻4

0   (bar-1) 1.11e-5 

𝐾𝐻2𝑂
0    (bar-1) 1.10e-5 

𝑅   kJ/mol.K 8.314e-3 

𝑇  K 877.7 

𝑇0  K 298 

 Fuente: (Adamu & Hossain, 2018) 

Las ecuaciones definidas de los modelos cinéticos de los productos principales de la 

reacción de gasificación con respecto al tiempo y eje longitudinal obtenidas con 

anterioridad fueron resueltas mediante el uso de Python con los parámetros indicados 

en la taba 4. Además, se consideró una masa catalítica de 3.92 g, un diámetro de reactor 

de 0.03 m como indica la investigación de Tacuri, (2021) en su estudio “Diseño y 

desarrollo de reactor de lecho fijo catalítico para la gasificación de biomasa de banano 

en la producción de hidrógeno”.  

3.2. Simulación 

 

Figura 9. Esquema general del sistema de gasificación de biomasa 

Fuente: (Tacuri, 2021) 

La simulación se realiza en dos fases. La primera fase consistió en establecer las 

condiciones de operación basados en el modelo de gasificación de biomasa propuesto 

por Tacuri (2021) en su trabajo “Diseño y desarrollo de reactor de lecho fijo catalítico 

para la gasificación de biomasa de banano en la producción de hidrógeno” El modelo 

se puede observar en la figura 9. En esta sección se realizó la simulación de la 
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transferencia de calor a través del horno y tubería de entrada con vapor para determinar 

temperaturas de trabajo. 

La segunda fase consistió en adoptar las condiciones de operación obtenidas en la 

simulación de la fase 1 con las condiciones globales generales e implementarlas a la 

gasificación de la glucosa con el modelo cinético base presentado por Adamu & 

Hossain, (2018) en su estudio “Kinetics of Steam Gasification of Glucose as a Biomass 

Surrogate over Ni/Ce–Mesoporous Al2O3 in a Fluidized Bed Reactor”. Esto se realiza 

con el objetivo de que la simulación adquiera replicabilidad y demuestre su 

adaptabilidad, ya que el análisis elemental de biomasa o la composición de la misma 

difiere dependiendo del tipo de fuente de la cual proviene la biomasa. Sin embargo; 

todos los tipos de biomasa tienen determinado contenido de glucosa en su composición; 

generalmente puede alcanzar hasta una concentración del 50.3%, por lo tanto, se 

asumió su fórmula química para el desarrollo del modelo cinético y en la formula global 

de la ecuación (35)  (Cruz, 2018). 

3.2.1. Transferencia de calor a través de la geometría modelo, el aislante 

ANSYS WORKBENCH proporciona una serie de herramientas para realizar análisis 

térmicos de ingeniería. Para ello es necesario definir condiciones de contorno, una 

estructura con un mallado bien definido y de manera óptima, condiciones térmicas y 

materiales. Para estudiar la distribución de calor en todo el sistema para la reacción de 

gasificación de biomasa se empleó el análisis térmico de estado estacionario (Steady-

State Thermal). Dicha función permite trabajar con la geometría, mallado de la misma, 

tipo de material y el estudio térmico, en este caso del aislante del horno. 

Además, Ansys posee una extensa biblioteca de diferentes materiales con sus 

respectivos propiedades y características, de acuerdo a los requerimientos de la 

simulación. También, permite añadir nuevos materiales con las características de las 

mismas, entre las más importantes, la densidad, la conductividad térmica, viscosidad 

ccinemática, calor específico, etc. 

Como primer paso se genera un sitema base en el módulo de trabajo, importando las 

geometrías, definiendo materiales y generando mallas; una vez hecho, se establecen 

condiciones de contorno para dar lugar a la simulación. 

Los pasos de la simulación se describen a continuación usando como modelo el proceso 

aplicado a la geometría del aislante. En el caso de las demás geometrías, el protocolo 

a seguir es el mismo variando en materiales y condiciones de contorno. 
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• En el Toolbox de Ansys Workbench se seleccionó el paquete Steady-State Thermal. 

• En el Steady-State Thermal, con clic derecho en la opción Geometry > Import 

Geometry se ingresó la geometría a la simulación.  

• Para ingresar a la información de la geometría, al mallado, asignación de las 

condiciones térmicas para la geometría etc., se accedió en la opción Model del 

Steady-State Thermal. 

• La designación del material se realizó como se indica en la tabla (5). 

 

Tabla 5. Asignación del material 

Tab Setting Value 

Geometry Material 

> Assignment 

 

E-glass(a) 

a. Corresponde al material de fibra de vidrio, empleado como aislante en los hornos. 

Fuente: Propia 

• Se generó mallado por defecto de la geometría modelo (aislante), mediante clic 

derecho en Mesh > Generate Mesh. 

 

Figura 10. Geometría del aislante del horno 

Fuente: Propia 

3.2.1.1. Mallado  

El mallado por defecto, generó una malla bastante sencilla constituida por triángulos y 

tetraedros, de tipo no estructurada recomendada para geometrías complejas, es decir, 

la red no posee un tipo de dirección referente, son menos precisas y requieren menor 

consumo de memoria computacional y menor tiempo de cálculo (Yupa, 2016). 
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Figura 11. Malla de la geometría del aislante 

Fuente: Propia 

3.2.1.2. Refinamiento de malla 

La mayoría de herramientas de discretización, genera mallas de manera automática, 

siendo necesarios únicamente ciertos parámetros como el tipo de elemento o la longitud 

del elemente. Dichos programas suelen arrojar como resultado mallas altamente 

irregulares. El refinamiento de malla permite hacer un análisis de comportamiento de los 

elementos cuando estos tiene un orden distinto de aproximación, presentando en la 

mayoría de los casos, una mayor estabilidad (Cerda, 2014). 

3.2.1.2.1. Refinamiento simple 

Con la finalidad de obtener un mallado más compacto y de mejor calidad, se empleó el 

método de tetraedros y un refinamiento de la malla. A continuación, se presenta los 

pasos a realizar: 

• Clic derecho en la opción Mesh > Insert > Method. 

• La configuración del método de mallado, se ajustó como se muestra en la siguiente 

tabla: 

Tabla 6. Configuración para el método de malla tetraédrico 

Tab Setting Value 

Scope Geometry  Aislante 

Definition Method Tetrahedrons 

Fuente: Propia 

• Clic derecho en la opción Mesh > Insert > Refinement. 

• Se configuró el refinamiento de la malla como se muestra en la siguiente tabla: 

Tabla 7. Configuración para el refinamiento de la malla 

Tab Setting Value 

Scope Geometry  Todas las caras de la 

geometría 
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Definition Refinement 3 

Fuente: Propia 

La malla generada a través del método tetrédrico con refinamiento queda de la siguiente 

forma, generando un mayor número de nodos que permite que se encuentren más 

compactos para mejorar la calidad y precisión en los cálculos y resultados de la 

simulación. En la Figura 12, se puede presenta la malla ya generada. 

 

Figura 12. Malla generada a través de método tetraédrico con refinamiento 

Fuente: Propia 

3.2.1.2.2. Refinamiento en ICEM CFD 

ICEM CFD es un paquete de generación de cuadriculas computacionales, específica 

para geometrías compleja, este paquete puede generar mallas estructuradas de 

bloques múltiples y mallas hexaédricas no estructuradas. En el caso de geometrías 

definidas como rectilíneas, el módulo del paquete hace una generación semiautomática 

con elementos no estructurados y elementos tetraédricos. En el caso de geometrías que 

impliquen curvas o formas cilíndricas, se realiza refinamiento con pirámides y prismas 

para zonas específicas dentro de la geometría (Wulf et al., 1995).  

Dentro del módulo ICEM CFD: 

• Clic derecho en la opción File > Import Model  

• Seleccionar el formato en el que se desea importar y dar click derecho en Apply. 

(extensiones recomendadas .iges y .step.) 

• La configuración de la geometría para visualización es: 
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Tabla 8. Configuración de la visualización de la geometría 

Tab Setting Value 

Geometry Subsets Cleared 

 Points Selected 

Curves Selected 

Surfaces Selected 

Fuente: Propia 

• Clic derecho en la opción Mesh > Global Mesh Setup > Global Mesh parameters 

• Verificar que los parámetros se encuentren en sus valores por defecto. 

 
Tabla 9. Configuración de los parámetros del Global Mesh 

Tab Setting Value 

Global Mesh Size Scale factor 1.0 

Seed Suize 5.0 

Volume Meshing Parameters Mesh type Tetra/Mixed 

Mesh Method Robust (Octree) 

Edge criterion 0.2 

Fuente: Propia 

• Clic derecho en la opción Part Mesh Setup > prism 

• Marcar las partes en las que se desea precisar el mallado (generalmente curvas) 

• Clic en Apply. 

• Clic derecho en la opción Mesh > Global Mesh Setup > Global Mesh parameters. 

 
Tabla 10.  Configuración en los ajustes del Prism Meshing Parameter 

Tab Setting Value 

Prism Meshing Parameters Growwth law Exponential 

Initial height 0.0399999 

Height ratio 1.3 

Number of layers 10 

Total Height 1.70478 

Fuente: Propia 

• Clic derecho en la opción Compute Mesh > Compute 

• Verificar que los parámetros se encuentren en sus valores por defecto. 
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Tabla 11. Configuración en los parámetros de Compute 

Tab Setting Value 

Volume Mesh Mesh Type Tetra/mixed 

Tetra/Mixed Mesh Mesh Method Robust (Octree) 

 Create Prism Layers Selected 

Fuente: Propia 

• Clic derecho en compute. 

   

Figura 13. Malla generada en ICEM CFD 

Fuente: Propia 

Una vez listas las configuraciones se ejecutan los parámetros, el tiempo de mallado 

dependerá del tipo de refinamiento, tamaño de malla y zonas que cuenten refinamiento 

especial.  

3.2.1.3. Condiciones de contorno 

Para conocer cómo se da la distribución de temperatura en el aislante se empleó dos 

herramientas, temperatura y convección, las cuales intervienen en el sistema planteado. 

Donde la temperatura es a la cual se calentó internamente el aislante del horno, y la 

convección corresponde a la generada por el ambiente a través de las paredes externas 

del horno. En la temperatura se seleccionó las superficies o caras de la geometría en 

las cuales se encuentra la fuente de calor y también se especificó el valor de dicha 

temperatura, siendo este de 640 °C. Con esta opción la simulación permitió determinar 

cómo se dio la conducción a través de la pared del aislante.  

En la configuración de convección se establecieron las caras que se ven afectadas, el 

coeficiente de convección y la temperatura ambiente a la cual están expuesta las caras. 

En este caso la convección se dio a través del aire y las paredes del horno, por lo que, 

las caras que presentan convección son aquellas que están en contacto con el exterior, 

con un coeficiente de transferencia de calor por convección de 5 W/m2.°C cuyo valor 
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corresponde a la convección natural del aire, el sistema se encontró expuesto a una 

temperatura ambiente de 22 °C, dicho valor corresponde a la temperatura del aire para 

lugares cerrados, debido a que las paredes externas del horno estaban expuestas al 

medio ambiente. 

Finalmente, para obtener y visualizar los resultados en la opción solución se encuentran 

los parámetros que pueden ser calculados, en este caso es de interés la distribución de 

temperatura de la geometría. Una vez introducidos los datos necesarios se dio lugar a 

la solución del problema. 

Las condiciones térmicas en la simulación se ingresaron de la siguiente manera: 

• En Steady-State Thermal (A5) click derecho > Insert > Temperature. 

• La configuración en los ajustes de temperatura se estableció como se indica en la 

tabla 12. 

Tabla 12. Configuración en los ajustes de temperatura 

Tab Setting Value 

Scope Geometry  Caras internas del 

aislante. Figura 14.a) 

Definition Magnitude 640 °C 

Fuente: Propia 

• En Steady-State Thermal (A5) click derecho > Insert > Convection 

• La configuración en los ajustes de convección se estableció como se indica en la 

tabla 13. 

Tabla 13. Configuración en los ajustes de convección 

Tab Setting Value 

Scope Geometry  Caras externas del 

aislante. Figura 14.b) 

Definition Film Coefficient  5 W/m2.C 

 Ambient Temperature 22 °C 

Fuente: Propia 

• En Solution (A6) clic derecho > Insert > Thermal > Temperature, en esta sección se 

mostrará los resultados de la simulación en la geometría aplicada. 

• Finalmente, se seleccionó Solver, para realizar los cálculos y obtener los resultados. 
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a)  

 

b) 

Figura 14. Superficies de las geometrías: a) Caras internas. b) Caras externas 

Fuente: Propia 

3.2.2. Flujo del agente gasificante 

El agua, empleada como agente gasificante en el proceso de gasificación ingresó al 

sistema a través de una tubería a una temperatura de 76.7 °C mientras la temperatura 

del horno se mantenía a 350 °C. Por lo tanto, la transferencia de calor se dio durante el 

paso del agua a través de la tubería, para estos casos la función indicada para estudiar 

este tipo de comportamientos es el CFX. 

3.2.2.1. Diseño de la geometría. 

La geometría del agente gasificante se adaptó a la de la tubería, es decir, un tubo de 

9,25 mm de diámetro y una longitud de 17 cm, dicho valor es el que recorre desde la 

entrada al horno hasta llegar al reactor. 

3.2.2.2. Mallado 

La geometría fue importada en la función Mesh, en la cual se generó la malla mediante 

el método tetraédrico y un refinamiento. La malla resultante se puede observar en la 

Figura 15, la misma que estuvo constituida por 16870 nodos. 

 

 Figura 15. Malla del agente gasificante 

Fuente: Propia 
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3.2.2.3. Pre-proceso (CFX-Pre) 

Esta etapa consistió en el ingreso de información que rige el proceso de transferencia 

de calor, es decir, condiciones de entrada, condiciones térmicas, características del 

fluido como velocidades, flujos másicos, etc.   

Para facilitar la identificación de las regiones de la geometría para la localización en la 

creación del dominio, de los límites de entrada y salida se nombré a la zona 1 como Inlet 

y la zona 2 como Outlet, mientras que toda la malla de la geometría se denominó como 

B111. 

 

Figura 16. Regiones de la malla del agente gasificante 

Fuente: Propia 

3.2.2.3.1. Creación del dominio fluido 

Se aplicó un modelo de transferencia de calor de energía térmica y un flujo laminar de 

acuerdo a los resultados de anexo 10. Para ello, se creó un dominio de fluido de toda la 

geometría, con los siguientes pasos. Además, los datos ingresados se muestran en la 

tabla 14. 

• Se creó un dominio en Insert > Domain. 

• En el cuadro Insertar Dominio, se colocó el nombre Vapor 

• La configuración de los ajustes fue: 

 
Tabla 14. Configuración para los ajustes del dominio Vapor 

Tab Setting Value 

Basic Settings Location and Type 

> Location 

 

B111 

Location and Type 

> Domain Type 

Fluid Domain 

Fluid and Particle Definitions  

> Fluid 1 

> Material 

 

 

Agua  

 Domain Models 

> Pressure 
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> Reference Pressure 1 atm 

Fluid Models Multiphase 

> Homogeneous Model 

 

(Selected) 

Heat Transfer 

> Option 

 

Thermal Energy 

Fuente: Propia 

3.2.2.3.2. Creación el límite de entrada 

• Se creó un nuevo límite en Insert > Boundary > denominado Inlet. 

• La configuración de los ajustes fue: 

 
Tabla 15. Configuración para los ajustes del límite de entrada Inlet 

Tab Setting Value 

Basic Settings Boundary Type Inlet 

Location Inlet 

Boundary Details Mass and Momentum 

> Normal Spedd 

 

 0.00645 m/s 

Heat Transfer 

> Static Temperature 

 

76.7 °C 

Fuente: Propia 

3.2.2.3.3. Creación el límite de salida 

• Se creó un nuevo límite en Insert > Boundary > denominado Outlet. 

• La configuración de los ajustes fue: 

 
Tabla 16. Configuración para los ajustes del límite de Salida Outlet 

Tab Setting Value 

Basic Settings Boundary Type Outlet 

Location Outlet 

Boundary Details Mass and Momentum 

> Normal Spedd 

 

 0.00645 m/s 

Fuente: Propia 

3.2.2.3.4. Edición del límite predeterminado Vapor 

Para la simulación de la transferencia de calor a través del dominio Vapor, se modificó 

algunos valores que se establecieron de manera automática. 
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La determinación del coeficiente de transferencia de calor se determinó a través de las 

fórmulas correspondiente a la convección interna forzada para el flujo de un líquido con 

una temperatura superficial constante, en este caso se consideró que el agente 

gasificante tenía una temperatura de 76,7 °C, con una temperatura superficial de 350 

°C. Las fórmulas empleadas fueron las siguientes: 

𝑅𝑒 =
𝑉1∗𝐷

𝜐
     (58) 

Donde 𝑅𝑒  es el número de Reynolds, 𝑉1  es la velocidad del agua, 𝐷  es el diámetro 

interno del tubo y 𝜐 la viscosidad dinámica del fluido. 

Al tratarse de una geometría cilíndrica de acuerdo con la Transferencia de calor y masa 

de Cengel A.  Para tubos circulares el número de Nusselt presenta un valor de 3,66. 

ℎ =
𝑘

𝐷
∗ 𝑁𝑢     (59) 

Donde ℎ es el coeficiente de transferencia de calor, 𝑘 es la conductividad térmica, y 𝑁𝑢 

es el número de Nusselt. 

Con la finalidad de dar validez a la simulación se calculó la temperatura de salida del 

fluido, que posteriormente se comparó con la temperatura de salida en la simulación. La 

temperatura de salida fue calculada de la siguiente manera: 

𝐴𝑠 = 𝜋 ∗ 𝐷 ∗ 𝐿     (60) 

Donde 𝐴𝑠 es el área lateral de la tubería y 𝐿 es la longitud de la tubería. 

𝑚̇ = 𝜌𝑎𝑔𝑢𝑎 ∗ 𝐴𝑐1 ∗ 𝑉1    (61) 

Donde 𝑚̇ es el flujo másico, 𝜌𝑎𝑔𝑢𝑎 es la densidad del agua, 𝐴𝑐1 es el área transversal de 

la tubería. 

𝑇𝑒 = 𝑇𝑠 − (𝑇𝑠 − 𝑇𝑖)𝑒
−

𝐴𝑠∗ℎ

𝑚̇∗𝐶𝑝     (62) 

Donde 𝑇𝑒  es la temperatura de salida, 𝑇𝑠  es la temperatura superficial, 𝑇𝑖  es la 

temperatura de entrada y  𝐶𝑝 es el calor específico. 

Los parámetros usados en las fórmulas corresponden a los del agua a una temperatura 

media de 213.35 °C. A continuación, se presenta una tabla con los valores necesarios 

para la aplicación de las fórmulas: 
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Tabla 17. Propiedades del agua y dimensiones de la tubería 

Parámetros Unidad Valor 

Densidad Kg/m3  840.300 

Conductividad térmica W/m.°C 0.650 

Calor específico J/kg.°C 4610.000 

Diámetro interno M 0.030 

Longitud de la tubería M 0.066 

Velocidad del agua m/s 6.45*10-3 

Temperatura superficial °C 350.000 °C 

Temperatura interna °C 76.700 °C 

Área m2 6.72*10-5 

Viscosidad cinemática m2/s 1.45*10-7 

Fuente: (Cengel, 2007; Tacuri, 2021) 

Una vez definidos los parámetros, se ingresó los datos en la simulación como se indica 

adelante. 

• En el Outline, en Vapor Default > Edit. 

• La configuración de los ajustes fue: 

 
Tabla 18. Configuración para los ajustes del límite predeterminado Housing 

Tab Setting Value 

Boundary Details Heat Transfer 

> Option 

 

Heat Transfer Coefficient 

Heat Transfer 

> Heat Trans. Coeff. 

 

250.86 W m-2 k-1(d) 

Heat Transfer 

> Outside Temperature 

 

350 °C 

Fuente: Propia 

3.2.2.3.5. Configuración de valores iniciales 

Los valores iniciales se establecieron de la siguiente manera: 

• En Insert > Global Initialiation. 

• La configuración para los ajustes fue: 

Tabla 19. Ajustes de los valores iniciales 

Tab Setting Value 

Global Settings Initial Conditions  
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 > Cartesian Velocity 

> Option 

 

Automatic with Value 

Initial Conditions 

> Cartesian Velocity 

> U 

 

 

0 m s-1 

Initial Conditions 

> Cartesian Velocity 

> V 

 

 

0 m s-1 

Initial Conditions 

> Cartesian Velocity 

> W 

 

 

0.00645 m.s-1 

Fuente: Propia 

3.2.2.4. Post-proceso (CFD) 

3.2.2.4.1. Creación de un plano de corte 

Es importante la creación de un plano, puesto que para otros gráficos de contorno y 

vectoriales requieren un localizador de plano de corte. El plano fue creado como se 

indica a continuación: 

• En Insert > Location > Plane denominado Plane 1. 

• La configuración de los ajustes fue: 

Tabla 20. Configuración para los ajustes plano de corte 

Tab Setting Value 

Geometry Definition 

> Method 

 

ZX Plane 

Deinition 

> X 

 

0 m 

Color Mode Variable 

Variable Temperature 

Range Global 

Fuente: Propia 

3.2.2.4.2. Creación de una polilínea 

La polilínea es necesaria para la creación del grafico de la caída de presión que se 

presenta más adelante. Para la creación de la polilínea se empleó el método de 

intersección de límite, el cual crea la polilínea a partir de la línea de intersección entre 

un objeto de límite y una ubicación, es decir, una pared y un plano, sus puntos son la 

línea de intersección que corta el borde de la malla de superficie. 
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• En Insert > Location > Polyline denominado Polyline 1. 

• La configuración de los ajustes fue: 

 
Tabla 21. Configuración para los ajustes de la polilínea 

Tab Setting Value 

Geometry Method Boundary Intersection 

Boundary List Vapor Default 

Intersect With Plane 1 

Color Mode Constant 

Color Yellow 

Render Line Width 3 

Fuente: Propia 

3.2.2.4.3. Creación de un contorno de temperatura 

También se creó contornos para observar el cambio de temperatura que presenta el 

agente gasificante cuando atraviesa la tubería, con la ayuda del plano creado con 

anterioridad. 

• En Insert > Contour denominado Contour 1. 

• La configuración de los ajustes fue: 

 
Tabla 22. Configuración para los ajustes del contorno 

Tab Setting Value 

Geometry Locations Plano 1 

Variable Temperature 

Range Global 

# of Contours 30 

Render Show Contour Bands (Cleared) 

Fuente: Propia 

3.2.3. Flujo a través de la biomasa y el catalizador 

Para determinar el comportamiento del flujo dentro del reactor, es necesario el uso de 

la herramienta CFX, el cual es un paquete de software de dinámica de fluidos 

computacional (CFD) que permite modelar en estados estacionarios y transitorios, flujos 

laminares, turbulentos, subsónicos, transónicos y supersónicos, transferencia de calor 

y radiación térmica, flotabilidad, flujos no newtonianos, transporte de componentes 

escalares que no reaccionan, flujos multifásicos, combustión, etc. ANSYS-CFX consta 
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de tres módulos: pre-proceso (CFX-Pre), solución (CFX-Solver) y post-proceso (CFD-

Post). 

3.2.3.1. Diseño de la geometría representativa del catalizador 

En este caso se empleó una geometría que consta del catalizador/biomasa y la entrada 

y salida del flujo como se puede observar en la Figura 17, donde el diámetro del 

catalizador/biomasa es de 3 cm correspondiente al diámetro interno del reactor y una 

altura de 6.6 cm, la entrada y salida del fluido a través de las tuberías, cuyo diámetro 

fue de 9.25 mm, correspondiente a las tuberías de acero inoxidable de ¼. 

 

Figura 17. Geometría del flujo a través de la biomasa y catalizador 

Fuente: Propia 

3.2.3.2. Mallado de la geometría 

Previo al uso del CFX, se importó la geometría y se generó el mallado con la herramienta 

Mesh, como se lo realizó anteriormente con las otras geometrías, aplicando el método 

tetraédrico y refinamiento. Por lo tanto, el mallado presentó 62028 número de nodos.  

 

 Figura 18. Malla del fluido en el reactor 

Fuente: Propia 

3.2.3.3. Pre-Proceso (CFX-Pre) 

Se inició el pre-proceso del CFX, en donde la información de la geometría y mallado se 

transfirió al CFX, el mismo que posee las siguientes opciones: el Setup donde encuentra 

la información de la malla, ingreso de datos y condiciones de entrada y salida para la 

simulación, etc. La opción Solution permite dar inicio a la etapa CFX-Solver y Result 

corresponde a la etapa CFD-Post. 

En la figura 19 a) la región B163 corresponde a la salida de la brida y tubería y B322 

corresponde a la entrada de la tubería y brida. Para facilitar la identificación de las 
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superficies en el ingreso de datos, se identificó a las regiones de la siguiente manera: 

1) PipeEnd 2, 2) PipeEnd, 3) FlangeEnd 2 y 4) FlangeEnd. 

 

a)  

 

b)  

Figura 19. Malla de la geometría. a) Regiones de la mallada para las tuberías y bridas. b) 

Ubicación de las regiones de la malla en las tuberías y bridas 

Fuente: Propia 

En la Figura 20, se identificó las regiones del catalizador denominado como Live, donde 

1 corresponde a Inlet y 2 a Outlet, Housing 1 y 2 son las caras laterales del cilindro. 

 

Figura 20. Regiones de la malla del catalizador. 

Fuente: Propia 

3.2.3.3.1. Creacción de una sola región para las mallas de las tuberías y bridas 

Las regiones B163 y B322, formaron parte de una sola región como se observa en la 

Figura 21. Para la creación de una región compuesta se logró con los siguientes pasos: 

• Insert > Regions > Composite Region 

• En cuadro de Insertar Región, se nombró como Cat y aceptar. 

• Para la configuración de la región compuesta se siguió las indicaciones de la tabla: 
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Tabla 23. Configuración para los ajustes de la región compuesta 

Tab Setting Value 

Basic Settings Dimension (Filter) 3D 

Region List B163, B322 

Fuente: Propia 

 

 Figura 21. Región compuesta Cat 

Fuente: Propia 

3.2.3.3.2. Creación del dominio fluido 

Para la simulación se empleó un modelo de transferencia de calor de energía térmica y 

un flujo laminar. Se creó un dominio de fluido con la región compuesta Cat, con los 

siguientes pasos. Además, los datos ingresados se muestran en la tabla 24. 

• Se creó un dominio en Insert > Domain. 

• En el cuadro Insertar Dominio, se colocó el nombre Pipes. 

• La configuración de los ajustes fue: 

 
Tabla 24. Configuración para los ajustes del dominio Pipes 

Tab Setting Value 

Basic Settings Location and Type 

> Location 

 

Cat 

Location and Type 

> Domain Type 

Fluid Domain 

Fluid and Particle Definitions Añadir nuevos fluidos 

denominados Fluid 1, 2, 3 

y 4. 

 Fluid and Particle Definitions  

> Fluid 1 

> Material 

> Fluid 2 

> Material 

> Fluid 3 

 

 

Vapor de agua 

 

Dióxido de carbono 
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> Material 

> Fluid 4 

> Material 

Hidrógeno 

 

Monóxido de carbono 

 Domain Models 

> Pressure 

> Reference Pressure 

 

 

1 atm 

Fluid Models Multiphase 

> Homogeneous Model 

 

(Selected) 

Heat Transfer 

> Option 

 

Thermal Energy 

Fuente: Propia 

3.2.3.3.3. Creación del dominio poroso 

La estructura del catalizador se modeló mediante la creación de un dominio poroso, para 

ello se determinó algunos parámetros tales como la caída de presión, el coeficiente de 

resistencia cuadrática y la densidad del área superficial. 

La resistencia direccional a lo largo de la corriente está alineada con el eje Z, cuyo valor 

se determinó con la ecuación (62). 

𝜕𝑝

𝜕𝑥𝑖
= −𝐾𝑄|𝑉|𝑉𝑖    (63) 

Donde 𝐾𝑄 es el coeficiente de la resistencia cuadrática, 𝑈𝑖 es la velocidad local en la 

dirección i, 
𝜕𝑝

𝜕𝑥𝑖
 es el gradiente de la caída de presión en la dirección de i. 

La caída de presión se calculó mediante la ecuación de Ergun, empleada comúnmente 

para medios porosos. 

𝜕𝑝

𝜕𝑥𝑖
=

150 𝑉0 𝜇

𝜙𝑠
2𝐷𝑝

2 ∗
(1−𝜀)2

𝜀3 +
1,75 𝜌 𝑉0

2

𝜙𝑠𝐷𝑝
∗

(1−𝜀)

𝜀3     (64) 

Donde 𝑉0 es la velocidad superficial o ficticia, 𝜇 es la viscosidad dinámica del fluido, 𝜀 

es la porosidad,  𝜌 es la densidad del fluido, 𝜙𝑠 es el factor de forma y 𝐷𝑝 es el diámetro 

de partícula. Los valores de densidad y viscosidad dinámica del fluido fueron 0.2992 

kg/m3 y 2.5859*10-5 Pa.s, respectivamente. 

La velocidad superficial o ficticia corresponde a la velocidad del lecho catalítico, es decir, 

el cociente entre el caudal (𝑄) y el área transversal del lecho (𝐴𝑐): 

𝑉0 =
𝑄

𝐴𝑐
      (65) 
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Otro dato necesario para la simulación es la densidad del área superficial, para obtener 

dicho valor se emplea la ecuación (65). 

𝜎 =
𝐴𝑐𝜀

𝑣
      (66) 

Donde 𝜎 es la densidad del área superficial, 𝐴𝑐 al área del catalizador, 𝜀 la porosidad 

del lecho catalítico y 𝑣 es el volumen del lecho. 

Los pasos para la creación del dominio son los siguientes: 

• Se creó un nuevo dominio en Insert > Domain 

• En el cuadro de Insertar dominio, se colocó el nombre de Housing. 

• La configuración de los ajustes para el dominio poroso se encuentra en la tabla 25: 

 
Tabla 25. Configuración para los ajustes del dominio Housing 

Tab Setting Value 

Basic 

Settings 

Location and Type 

> Location 

 

LIVE 

Location and Type 

> Domain Type 

 

Porous Domain 

Fluid and Particle Definitions  

> Fluid 1 

> Material 

> Fluid 2 

> Material 

> Fluid 3 

> Material 

> Fluid 4 

> Material 

 

 

Vapor de agua 

 

Dióxido de carbono 

 

Hidrógeno 

 

Monóxido de carbono 

Solid Definitions (Añadir un nuevo sólido) Nickel 

Solid Definitions 

> Nickel 

> Material 

 

 

Nickel 

Domain Model 

> Pressure 

> Reference Pressure 

 

 

1 atm 
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Fluid 

Models 

Heat Transfer 

> Option 

 

Thermal Energy 

Solid 

Models 

Heat Transfer 

> Option 

 

Thermal Energy 

Porosity 

Settings 

Volume Porosity 

> Option 

 

Value 

Volume Porosity 

> Volume Porosity 

 

0.46(a) 

Loss Model 

> Option  

Directional Loss 

Loss Model 

> Loss Velocity Type 

Superficial(b) 

Loss Model 

> Directional Loss 

> Streanwise Direction 

> Option 

 

 

 

Cartesian Components 

Loss Model 

> Directional Loss 

> Streanwise Direction 

> X Component  

 

 

 

0 

Loss Model 

> Directional Loss 

> Streanwise Direction 

> Y Component 

 

 

 

0 

Loss Model 

> Directional Loss 

> Streanwise Direction 

> Z Component 

 

 

 

-1 

Loss Model 

> Directional Loss 

> Streanwise Loss 

> Option 

 

 

 

Linear and Quadratic Coeffs 

Loss Model 

> Directional Loss 

> Streanwise Loss 
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> Quadratic Resistance Coefficient (Selected) 

Loss Model 

> Directional Loss 

> Streanwise Loss 

> Quadratic Coefficient 

 

 

 

0 kg m-4 (c) 

Loss Model 

> Directional Loss 

> Transverse Loss 

> Option  

 

 

Streamwise Coeff Multiplier 

Loss Model 

> Directional Loss 

> Transverse Loss 

> Multiplier  

 

 

 

10(d) 

Fluid Solid Area Density 

> Interfacial Area Den 

 

7.67 m-1 

Fluid Solid Heat Transfer 

> Heat Trans. Coeff. 

 

250 W m-2 k-1(e) 

a. Es la porosidad calculada en el anexo 2. 

b. Es la velocidad a la que viajaría el flujo si la porosidad del dominio fuera el 100%, 

es menor a la velocidad real. 

c. Valor definido en el anexo 8. 

d. Valor predeterminado para la pérdida transversal. 

e. Coeficiente de transferencia de calor para vapor sobrecalentado (convección 

forzada) (Cengel, 2007). 

Fuente: Propia 

3.2.3.3.4. Creación el límite de entrada 

Los pasos realizados en la simulación para el límite de entrada fueron los siguientes: 

• Se creó un nuevo límite en Insert > Boundary > Pipes denominado Inlet. 

• La configuración de los ajustes fue: 

 
Tabla 26. Configuración para los ajustes del límite de entrada Inlet 

Tab Setting Value 

Basic Settings Boundary Type Inlet 

Location PipeEnd 2 

Boundary Details Mass and Momentum  
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> Normal Spedd  0.00645 m/s 

Heat Transfer 

> Static Temperature 

 

76.7 °C 

Fuente: Propia 

3.2.3.3.5. Creación del límite de salida 

• Se creó un nuevo límite en Insert > Boundary > Pipes denominado Outlet. 

• La configuración de los ajustes fue: 

 
Tabla 27. Configuración para los ajustes del límite de entrada Outlet 

Tab Setting Value 

Basic Settings Boundary Type Outlet 

Location PipeEnd  

Boundary Details Mass and Momentum 

> Option 

 

Static Pressure 

Mass and Momentum 

> Relative Pressure 

 

0 Pa. 

Fuente: Propia 

Las superficies exteriores restantes se crearon de forma automáticamente a los límites 

predeterminados: Housing Default y Pipes Default. 

3.2.3.3.6. Edición del límite predeterminado Housing 

Para la simulación de la transferencia de calor a través del dominio Housing, se modificó 

algunos valores que se establecieron por defecto. 

De la misma manera que se realizó en la simulación del agente gasificante y el calculó 

el coeficiente de transferencia de calor, considerando los parámetros que se encuentran 

en la tabla 28, cuyas propiedades del agua fueron tomadas a una temperatura media de 

431.85 °C. 

Tabla 28. Propiedades del agua y dimensiones del lecho 

Parámetros Unidad Valor 

Densidad Kg/m3  0.313 

Conductividad térmica W/m.°C 0.059 

Calor específico J/kg.°C 2088.614 

Diámetro interno m 0.030 

Longitud del lecho  m 0.066 

Velocidad del agua m/s 1.33*10-3 
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Temperatura superficial °C 637.200 °C 

Temperatura interna °C 226.500 °C 

Área m2 7.07*10-4 

Viscosidad cinemática m2/s 8.3013 

Fuente: (Cengel, 2007; Tacuri, 2021) 

Los datos para la región de Housing Default se modificaron de la siguiente manera: 

• En el Outline, en Housing Default > Edit 

• La configuración de los ajustes fue: 

 
Tabla 29. Configuración para los ajustes del límite predeterminado Housing 

Tab Setting Value 

Boundary Details Heat Transfer 

> Option 

 

Wall Heat Transfer Coefficient 

Heat Transfer 

> Heat Trans. Coeff. 

 

7.198 W m-2 k-1(a) 

Heat Transfer 

> Outside Temperature 

 

637.2 °C 

Solid Values Boundary Conditions 

> Nickel 

> Heat Transfer 

> Option 

 

 

 

Heat Transfer Coefficient 

Boundary Conditions 

> Nickel 

> Heat Transfer 

> Heat Trans. Coeff. 

 

 

 

7.198W m-2 k-1(a) 

Boundary Conditions 

> Nickel 

> Heat Transfer 

> Outside Temperature 

 

 

 

637.2 °C 

a. Valor determinado en anexo 11. 

Fuente: Propia 

3.2.3.3.7. Configuración de valores iniciales. 

Suponiendo que la velocidad inicial es la que se dará a través de la carcasa, y al 

considerar un flujo incompresible con la aplicación de la conservación de masa la 
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velocidad aproximada será el correspondiente a la V2, la misma que fue determinada 

con la ecuación (69). 

𝑉2 =
𝑄

𝐴𝑐∗𝜀
     (67) 

Los valores iniciales se establecieron de la siguiente manera: 

• En Insert > Global Initialiation. 

• La configuración para los ajustes fue: 

 
Tabla 30. Ajustes de los valores iniciales 

Tab Setting Value 

Global Settings 

 

Initial Conditions 

> Cartesian Velocity 

> Option 

 

 

Automatic with Value 

Initial Conditions 

> Cartesian Velocity 

> U 

 

 

0 m s-1 

Initial Conditions 

> Cartesian Velocity 

> V 

 

 

0 m s-1 

Initial Conditions 

> Cartesian Velocity 

> W 

 

 

 0.00133m.s-1 

Fuente: Propia 

3.2.3.3.8. Configuración del control del solucionador 

• En Insert > Solver > Solver Control 

• Se realizó los siguientes ajustes: 

 
Tabla 31. Ajustes del control del solucionador 

Tab Setting Value 

Basic Settings Convergence Control 

> Fluid Timescale Control 

> Timscale Control 

 

 

Physical Timescale 

Convergence Control 

> Fluid Timescale Control 

> Physical Timescale 

 

 

0.04 s 

Fuente: Propia 
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Una vez ingresada toda la información necesaria en el pre-proceso, se dio inicio a la 

solución de la simulación en la opción Define Run, el proceso de resolución se llevó a 

cabo por CFX-Solver. 

3.2.3.4. Post-proceso (CFD-Post) 

En esta etapa se muestran los resultados de la simulación, donde fue posible analizar 

la distribución de temperatura, presión y velocidad. Para ello se crearon planos, 

polilíneas, superficies, vectores en el plano, contornos, gráficos.  

3.2.3.4.1. Creación de un plano de corte. 

El plano fue creado como se indica a continuación: 

• En Insert > Location > Plane denominado Plane 1. 

• La configuración de los ajustes fue: 

 
Tabla 32. Configuración para los ajustes plano de corte 

Tab Setting Value 

Geometry Definition 

> Method 

 

YZ Plane 

Deinition 

> X 

 

-0.012 m 

Color Mode Variable 

Variable Temperaturea 

Range Global 

a. Se puede seleccionar otras variables como presión, temperatura, velocidades, 

fracciones volumétricas, etc. 

Fuente: Propia 

3.2.3.4.2. Creación de una polilínea 

• En Insert > Location > Polyline denominado Polyline 1. 

• La configuración de los ajustes fue: 

 
Tabla 33. Configuración para los ajustes de la polilínea 

Tab Setting Value 

Geometry Method Boundary Intersection 

Boundary List Housing Default, Pipes Default 

Intersect With Plane 

Color Mode Constant 
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Color Yellow 

Render Line Width 3 

Fuente: Propia 

3.2.3.4.3. Creación de un contorno de presión 

Se crearon contornos para observar la caída de presión a través del cuerpo catalítico, 

con la ayuda del plano creado con anterioridad. 

• En Insert > Contour denominado Contour 1. 

• La configuración de los ajustes fue: 

 
Tabla 34. Configuración para los ajustes del contorno 

Tab Setting Value 

Geometry Locations Plano 1 

Variable Presurea 

Range Global 

# of Contours 30 

Render Show Contour Bands (Cleared) 

a. Se puede seleccionar otras variables como presión, temperatura, velocidades, 

fracciones volumétricas, etc. 

Fuente: Propia 

3.2.3.4.4. Creación de gráficos de presión versus la coordenada Z. 

Para analizar la caída de presión a través del catalizador se creó un gráfico de la presión 

vs la coordenada Z. Además, se puede crear otros gráficos con otras variables. 

• En Insert > Chart denominado Chart 1. 

• La configuración de los ajustes fue: 

 
Tabla 35. Configuración para los ajustes del gráfico de presión vs el eje Z 

Tab Setting Value 

Geneal Title Caída de presión a través 

del catalizador 

Data Series Name Caída de presión 

Data Source 

> Location 

 

Polyline 1 

X Axis Data Selection 

> Variable 

 

Z 

Y Axis Data Selection  
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> Variable Pressurea 

Line Display Pressure Drop (Selected) 

Line Display 

> Line Style 

 

None 

Line Display 

> Symbols 

 

Rectangle 

Chart Display Sizes 

> Symbol 

 

3 

a. Se pueden crear otros gráficos cambiando la variable a temperatura, velocidad o 

presión con respecto a la coordenada Z. 

Fuente: Propia 
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CAPITULO 4: RESULTADOS Y DISCUSIÓN 

4.1.  Distribución de la temperatura a través del sistema 

4.1.1. Modelo unidimensional de la distribución de temperatura. 

 

a)  
b)  

 

c)  

Figura 22. Distribución de temperatura del modelo unidimensional a) A través del aislante.  b) 

A través del aire del reactor. c) A través del reactor 

Fuente: Propia 

En la figura 22 a), b), c) se observa la distribución de temperatura a través del modelo 

unidimensional de la estructura original, representado por placas. Se obtuvieron 

resultados para la distribución en cada sistema, el aislante, entre el aire y el reactor y a 

través de las paredes del reactor. La distribución de calor está representada por un 
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esquema de colores que adopta el patrón de arcoíris; la zona de mayor temperatura se 

indica por el color rojo disminuyendo hasta la de menor temperatura representada por 

el color azul. 

Mediante los resultados obtenidos de la solución matemática anexo 1, se puede 

comprobar que la simulación se lleva de manera correcta, pues la variación en la 

temperatura obtenida en los dos métodos, es nula.  

4.1.2. Modelo tridimensional de la distribución de temperatura. 

4.1.2.1. Temperatura en el aislante del horno. 

 

Figura 23. Distribución de temperatura a través del aislante del horno 

Fuente: Propia 

El calor transferido por conducción a través del aislante se presenta en la Figura 23. La 

distribución de calor se llevó a cabo debido a una diferencia de temperatura desde la 

zona de mayor temperatura hacia la zona de menor temperatura. El aire del horno se 

calentó hasta 640 °C, representados por el color rojo más intenso, las paredes del 

aislante se encuentran en convección con el aire del ambiente a una temperatura de 22 

°C, con un coeficiente de transferencia de calor por convección de 5
𝑊

𝑚2∗𝐾
. Además, al 

tratarse de un material aislante su conductividad térmica es de 0.04
𝑊

𝑚∗𝐾
; esto hace que, 

en la superficie de las paredes externas, la temperatura alcance alrededor de 120 °C, 

intentado conservar el calor. Estos resultados coinciden con los del modelo 

unidimensional mostrados en la Figura 22.a) y los resultados calculados 

matemáticamente mostrados en el anexo 1. 
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a) 

 

b) 

Figura 24. Distribución de temperatura en el aislante a) Refinamiento simple b) Refinamiento 

en  

ICEM CFD 

Fuente: Propia 

Tabla 36. Número de nodos en las mallas del aislante dentro del horno 

Tipo de refinamiento N° de nodos 

Por defecto 3865 
Simple 48206 
ICEM CFD 127425 

Fuente: Propia 

En la Figura 23.a) se observa la transferencia de calor a través de la estructura con 

refinamiento simple, tal y como lo muestra la tabla 36, el número de nodos se incrementó 

hasta 48206; en este caso, la temperatura de la superficie en la pared del aislante, tuvo 

apenas una variación de 1 °C llegando a ser de aproximadamente 121 °C. En la Figura 

24.b) se encuentra la malla obtenida del refinamiento en ICEM CFD, el número de nodos 

aumentó hasta 127425, en este caso, la variación en la temperatura de la pared del 

aislante es apenas de 0.47 de diferencia. Esta pequeña variación, en relación con el 

incremento en el número de nodos, nos permite observar que, aunque el refinamiento 

se vuelva más regular, la variación en la forma en la que se distribuye el calor, no es 

significativa. Lo que nos indica que, para este caso la calidad de la malla no influye 

significativamente en los resultados obtenidos. 
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4.1.2.2. Temperatura en el aire dentro del horno. 

 

Figura 25. Distribución de temperatura en el aire del horno 

Fuente: Propia 

La distribución de calor a través del aire del horno se presenta en la Figura 25. El aire 

del horno se calentó hasta 640 °C, representado por el color rojo; el color azul representa 

la zona de contacto entre el aire y el reactor. El calor se transfirió en este sistema 

mediante convección del aire caliente hacia las paredes del reactor, con un coeficiente 

de transferencia de calor por convección de 30
𝑊

𝑚2∗𝐾
 . La conductividad térmica del acero 

es de 60.5
𝑊

𝑚∗𝐾
; razón por la cual, la temperatura en la zona que representa la superficie 

del reactor, alcanza los 639.41 °C; misma que presenta Tacuri, (2021) en su trabajo 

“Diseño y desarrollo de reactor lecho fijo catalítico para gasificación de biomasa de 

banano en la producción de hidrógeno”. 

 

a) 

 

b) 

 Figura 26. Distribución de temperatura en el aire del horno a) Refinamiento simple b) 

Refinamiento en ICEM CFD 

Fuente: Propia 
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Tabla 37. Número de nodos en las mallas del aire dentro del horno 

 

 

Fuente: Propia 

Usando un refinamiento simple, como se muestra en la Figura 26.a) y en la tabla 37 el 

número de nodos se incrementó hasta 64659; por otra parte, usando el módulo especial 

para mallado ICEM CFD, se logró incrementar la cantidad de nodos hasta 210734, esto 

se muestra en la Figura 26.b) y tabla 37. La diferencia en uniformidad de mallado, es 

fácilmente visible, los elementos se acomodan a la estructura general generando el 

aumento en el número de nodos. La temperatura establecida del aire del horno fue de 

640 °C, por lo que esta no presenta variación, la zona azul que representa las paredes 

del reactor, presenta una variación de 0.01 °C por lo que incluso un mallado más 

refinado, no implicó una variación significativa en los resultados.  

4.1.2.3. Temperatura en el reactor 

 

Figura 27. Distribución de temperatura a través del reactor 

Fuente: Propia 

En la Figura 26 se presenta la distribución de calor a través del reactor, la temperatura 

en la superficie del reactor fue de 639.41 °C (Tacuri, 2021); misma que pudo 

comprobarse en la simulación que se observa en la Figura 25. La temperatura 

introducida para el aire dentro del reactor fue de 386 °C con un coeficiente de 

transferencia de calor por convección de 30
𝑊

𝑚2∗𝐾
 , representando el cuerpo de aire, 

dicha temperatura fue físicamente presentada por (Tacuri, 2021) en su trabajo “Diseño 

y desarrollo de reactor lecho fijo catalítico para gasificación de biomasa de banano en 

la producción de hidrógeno”. 

Tipo de refinamiento N° de nodos 

Por defecto 5452 
Simple 64659 
ICEM CFD 210734 
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La zona azul representa la superficie de contacto del aire dentro del horno con las 

paredes del mismo, hubo una ligera pérdida de calor que se ve reflejada en el  valor de 

637.67 °C en dicha zona. 

 

a) 

 

b) 

 Figura 28. Distribución de temperatura en el reactor a) Refinamiento simple b) Refinamiento 

ICEM CFD 

Fuente: Propia 

Tabla 38. Número de nodos en las mallas del reactor del horno 

Tipo de refinamiento N° de nodos 

Por defecto 4417 
Simple 52874 
ICEM CFD 59645 

Fuente: Propia 

Al igual que en los resultados anteriores, se presentan las distribuciones de calor a 

través del reactor con sus respectivos refinamientos. En el mallado simple, se consiguió 

elevar el número de nodos hasta 52874, mientras que usando ICEM CFD, este valor 

aumentó hasta 59645; resultados que se presentan en la tabla 38 y las figuras 28 a) y 

b), respectivamente. Al igual que los resultados anteriores, es fácilmente visible una 

malla más uniforme y elementos más regulares. No se presenta variación en la zona de 

principal interés que es la de contacto entre las paredes internas del reactor y el aire 

dentro. 
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4.1.3. Cambio de temperatura del agente gasificante 

 

Figura 29. Temperatura del agente gasificante a través de la tubería 

Fuente: Propia 

El agua empleada como agente gasificante recorrió una longitud de 17 cm dentro del 

horno hasta llegar al reactor, recorrido en el cual aumentó su temperatura 

considerablemente, gracias al haber estado sometida a una temperatura externa de 350 

°C, puesto que ingresó a una temperatura de 76.7 °C, presentando un coeficiente de 

transferencia de calor de 250.86 W/m2.°C, según los cálculos realizados en el anexo 6. 

De acuerdo a la simulación, la temperatura de salida fue de 226.85 °C como se puede 

observar en la figura 30, pudiendo observar cómo se da el aumento de su temperatura 

a lo largo de la tubería. Por otra parte, en los resultados obtenidos en los cálculos del 

anexo 7, la temperatura de salida fue de 219.41 °C, presentan una ligera variación de 

7.44 °C, entre los resultados de la simulación y los cálculos matemáticamente. De esta 

forma se logró obtener e identificar la temperatura de entrada del agente gasificante al 

reactor, pudiendo generar vapor sobrecalentado necesario para que se lleve a cabo la 

reacción. 

4.2. Comportamiento del fluido dentro del reactor 

4.2.1. Velocidad a través del reactor. 

Como se muestra en las Figuras 31 y 32, la velocidad del fluido en la tubería es de 

0.0065 m/s, una vez que entra al lecho de biomasa y catalítico, presentó una 

disminución considerable al tener que atravesar todo el lecho. En la parte central del 

reactor el flujo tuvo una velocidad de aproximadamente 0.00185 m/s cercana a la 

velocidad estimado en los cálculos presentados en el anexo 13. También se observa 
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que la velocidad a medida que está más cerca de las paredes del reactor tiende a cero, 

fenómeno que puede ser observado de mejor manera en la Figura 30. 

 

Figura 30. Comportamiento de la velocidad del fluido 

Fuente: Propia 

 

Figura 31. Velocidad del fluido a través de la coordenada Z 

Fuente: Propia 

4.2.2. Temperatura a través del reactor. 

En las Figuras 33 y 34 nos indica la distribución de temperatura a lo largo del sistema, 

de acuerdo a la simulación la temperatura de salida del agente gasificante presentó un 

valor de 226.85 °C, y una temperatura en la pared interna de 637.2 °C, cuyo dato fue 
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obtenido previamente. Por lo tanto, el ingreso del fluido al reactor y al ser expuesta a 

dicha temperatura, ésta aumenta considerablemente, muy cercana a la temperatura del 

horno de 640 °C. La parte central del lecho adquirió aproximadamente 604.7 °C debido 

a la presencia del lecho de la masa y el catalizador, dicha temperatura es la necesaria 

y suficiente para llevar a cabo la gasificación de la biomasa, la misma que fue empleada 

en la simulación de la reacción de gasificación. Finalmente el fluido presentó una 

temperatura de salida 633.8 °C, que en comparación con la calculada en el anexo 12, 

tuvó una variación de 3.4 °C.  

 

Figura 32. Distribución de temperatura del fluido 

Fuente: Propia 

 

Figura 33. Variación de temperatura con respecto al eje Z 

Fuente: Propia 
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4.2.3. Caída de presión a través del reactor. 

En las Figuras 35 y 36 debido a resistencia que presenta el fluido a pasar a través del 

lecho de la biomasa y el catalítico, se generó una caída de presión a medida que el 

vapor y los gases generados atravesaron el reactor, provocando al final una presión 

negativa, es decir, inferior a la atmosférica o subatmosférica. Debido a este fenómeno 

los gases se expandan al disminuir su densidad y ascienden a través del reactor, 

permitiendo la salida de los mismos, aumentando también la velocidad a la salida del 

reactor como se evidencia en las figuras 31 y 32. 

 

Figura 34. Variación de la presión a través del reactor 

Fuente: Propia 

 

Figura 35. Caída de presión con respecto al eje Z 

Fuente: Propia 
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4.3. Simulación de la reacción de gasificación 

4.3.1. Evolución del número de moles con respecto al tiempo 

 

 
 

a)  

 
b)  

 
c)  

 
d)  

 
e)  

  
Figura 36. Evolución del comportamiento de flujos molares resultantes de la reacción de 

gasificación de glucosa a través del tiempo. a) Flujo de Hidrógeno b) Flujo de monóxido de 

carbono b) Flujo de dióxido de carbono d) Flujo de metano e) Flujo de agua. 

Fuente: Propia 

En la Figura 37 c) y d), es evidente que existe un aumento en la producción de dióxido 

de carbono y metano ya que estos son dos productos finales tanto en WGS y en RDRM. 

Tanto la generación de componentes como la gasificación de la glucosa alcanza un 
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punto estable y se vuelve constante a partir de cierto tiempo de residencia (Chowdhury 

et al., 2018). 

En la figura 37.a) muestra la evolución en la obtención de hidrógeno; al ser un producto 

que se convierte en reactivo en la reacción de reformado en seco de metano RDRM, 

presenta una caída en la evolución de la curva hasta que se estabiliza aproximadamente 

en 0.16 mol/s. Salinas & García (2019) en su trabajo “Producción de hidrógeno a través 

de la gasificación de glucosa usando catalizadores de 5% Ni con 2% de La, Ce y Mg y 

deducción de una ecuación de velocidad de reacción intrínseca”; reporta valores 

resultantes aproximados a 0.3 mol/s para temperaturas cercanas a los superiores a 600 

°C y catalizadores con contenidos de níquel superiores. Cruz (2018), en su estudio 

“Producción de hidrógeno a través de la gasificación de glucosa usando catalizadores 

de γ-Al2O3 con Ni, Ce y La e interpretación de resultados usando un modelo No-

estequiométrico”, en el cual hace uso de la glucosa como modelo de biomasa, obtiene 

los valores más altos de producción de hidrógeno usando una temperatura de hasta 600 

°C en un tiempo de reacción de 30 segundos. 

La reducción significativa final de monóxido de carbono Figura 37.b), a comparación con 

la producción de Hidrógeno Figura 37.a), muestra que en la reacción RDRM, que 

presenta como reactivos a estos dos elementos, se consume principalmente CO. Esto 

tiene sentido observando los flujos molares obtenidos siendo 0.16 mol/s para el H2 y 

0.08 para CO. 

La presencia de monóxido de carbono, como un agente reductor fuerte durante un ciclo 

redox, produce además de hidrógeno, dióxido de carbono (Chowdhury et al., 2018). Tal 

y como se observa en la figura 37.c), ocurre un incremento progresivo en la generación 

de CO2 hasta alcanzar un flujo constante de 0.16 mol/s. Observado las reacciones que 

ocurren en la gasificación de glucosa, se atribuye este comportamiento a la formación 

de tales productos en WGS y RDRM.  

La figura 37.d) muestra la evolución de la producción de metano que corresponde a 

RDRM en donde se forma como producto final, sin embargo, su formación no prima 

sobre la formación de CO2 probablemente porque éste último también se obtiene como 

producto en WGS y desde ahí va en aumento hasta finalizar la reacción. El caudal final 

del metano es de 0.12 mol/s; Si el metano se forma únicamente por la reacción de 

metanización, las tendencias tanto del CO y H2, disminuirá con el tiempo (Chowdhury et 

al., 2018); sin embargo, al ser uno de los caudales más bajos, demuestra que WGS 

predomina sobre las reacciones de metanización.  
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En la figura e) se puede observar el comportamiento de H2O; esta siempre se consume 

como reactivo tanto en WGS como en SRM, por lo tanto, su curva decrece hasta que 

naturalmente alcanza un flujo constante de 0.10 mol/s. 

 

Figura 37. Relación Hidrógeno/Monóxido de Carbono con respecto al tiempo 

Fuente: Propia 

La Figura 38 muestra una relación constante H2:CO de 2.2 aproximadamente. (Gómez, 

2019) en su trabajo “Catálisis Heterogénea para el Aprovechamiento Energético de la 

Biomasa”, reporta valores cercanos o iguales a 2 para lograr un óptimo aprovechamiento 

del hidrógeno como caudal de alimentación para la producción de etanol, nafta y 

tecnología que haga uso de este tipo de gas. Generalmente, una relación H2:CO 

elevada, se presenta cuando se trabaja a temperaturas altas, sobrepasando los 500 °C, 

llegando a ocupar rangos entre 1.7- 2 (Song & Guo, 2006), cumpliendo con lo 

presentado por el estudio mismo que se llevó a cabo a 604,05 °C. 

4.3.2. Evolución del número de moles con respecto al eje longitudinal 

 

a) 

 

b) 
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c) 

 

d) 

 

e) 

Figura 38. Evolución del comportamiento de flujos a través del eje axial z. a) Flujo de 

Hidrógeno b) Flujo de monóxido de carbono c) Flujo de dióxido de carbono d) Flujo de metano 

e) Flujo de agua. 

Fuente: Propia 

 

Figura 39. Relación Hidrógeno/Monóxido de Carbono con respecto al eje Z 

Fuente: Propia 

La Figura 39 muestra la evolución del flujo molar a través del eje longitudinal; este 

apartado se hizo aumentando la presión hasta 2 bares para estudiar cambios 

significativos en la gasificación. De igual manera que en la Figura 37, en cada curva se 

observan comportamientos exactamente similares en cuanto a tendencia.  

La Figura 39.a) muestra una caída medianamente significativa hasta que alcanza el 

estado estable. Esto se explica porque el hidrógeno se consume en RDRM. Lo mismo 
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ocurre en la Figura 39.b) cuya tendencia disminuye debido a que se consume en WGS 

que es la reacción que prima. En el caso del dióxido de carbono cuyo comportamiento 

se exhibe en la figura 39.c) cuya tendencia es creciente porque, se genera únicamente 

en WGS siendo esta la reacción predominante. La reacción de reformado en seco de 

metano, muestra la formación de metano en conjunto con dióxido de carbono; a pesar 

de tener una tendencia creciente similar, se produce en menor cantidad que CO2, esto 

se puede observar en la figura 39.d). En WGS y SRM, uno de los reactivos es agua, 

este consumo lo muestra la figura 40 Finalmente, se obtuvo la misma relación H2:CO 

siendo la misma resultante que en el estudio con respecto al tiempo. 
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CONCLUSIONES 

Dadas las limitaciones del trabajo base, se presentó un modelo que adapta condiciones 

reales de trabajo verificadas luego de haber realizado una primera simulación térmica 

en Ansys con la posterior simulación de la cinética de la reacción en Python con un 

modelo de biomasa, glucosa. Gracias a la primera, se logró determinar una temperatura 

de trabajo, la temperatura de entrada del agente gasificante a través de uso de la 

herramienta CFX, con la ayuda de simulaciones anteriores de la transferencia de calor 

a través del aislante, horno y reactor, las mismas que fueron verificados a través de 

cálculos de transferencia de calor, que al comparar los valores de la simulación y los 

calculados no presentan una variación significativa. De esta manera se identificó la 

temperatura en la pared interna del reactor. 

Se realizaron dos tipos de refinamientos de malla, uno dentro del módulo Steady-State 

Thermal y otro dentro del módulo ICEM CFD. Gracias a esto, se logró comprobar que 

sin importar que se trabajase en una discretización más sensible, para este caso 

específico de estudio, las variaciones entre resultados para la transferencia de calor no 

son significativas entre simulaciones. Por lo tanto, centrar recursos en mejorar este 

aspecto, solo implica la generación de mayores costos computacionales; por lo que la 

mejor opción es presentar modelos sencillos de refinamiento que permiten obtener 

aproximaciones generales pero precisas.  

La simulación posterior de la gasificación mediante los modelos cinéticos con respecto 

al tiempo y el eje longitudinal de los principales productos de la reacción arrojó flujos 

molares para H2, CO, CO2, CH4 y H2O, cuyos resultados no presentaron una variación 

significativa. En cuanto a la relación H2:CO, se determinó que las condiciones iniciales 

fueron ideales para obtener un valor de 2.2 en dicha relación, llegando a igualar los 

valores reportados por otros autores. 

El trabajo deja sentadas las bases de un modelo cinético y condiciones operativas que, 

gracias al uso de software especializado y bajo un estudio específico para cada caso, 

puede ser adaptable sin la necesidad de invertir recursos económicos y de carácter 

logístico como lo haría una implementación física.  
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RECOMENDACIONES 

 

• Trabajar con una temperatura de entrada elevada del agente gasificante, es decir, 

en estado de vapor saturado, dentro de las condiciones de operación establecidas 

para el caso de estudio antes de la entrada al horno, para disminuir el tiempo de 

operación total. 

• Resultaría un buen punto de enfoque, variar el tamaño de partícula del catalizador 

con el fin de realizar pruebas adoptando diferentes porosidades y determinar un 

diámetro final de optimización en la producción de hidrógeno. 

• Realizar un análisis elemental previo de la materia prima que se vaya a someter a 

gasificación y así construir un modelo cinético específico. 

• Realizar un estudio económico comparativo con la materia prima “en bruto” y de 

glucosa proveniente de ésta, con el propósito de determinar la rentabilidad de cada 

investigación. 

• Determinar mediante un estudio los parámetros cinéticos, tales como constante de 

velocidad de equilibrio, constantes de velocidad de reacción, constantes de 

velocidad de adsorción del componente de las reacciones dominantes en la 

gasificación específicas para la biomasa, con la finalidad de mejorar el modelo 

cinético para su respectiva simulación. 
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ANEXOS 

ANEXO 1: Cálculo de la temperatura en la superficie del aislante 

Cálculo del área 

𝐴 = 𝑙2 

𝐴 = (0.17𝑚)2 

𝐴 = 0.029𝑚2 

Cálculo de U 

𝑈 =
1

1
ℎ1

+
𝐿1
𝑘1

 

𝑈 =
1

1

5
𝑊

𝑚2 ∗ °𝐶

+
0.04𝑚
0.04𝑚

 

𝑈 = 0.833
𝑊

𝑚2 ∗ °𝐶
 

Cálculo del calor 

𝑞 = 𝑈 ∗ 𝛥𝑇 

𝑞 = 0.833
𝑊

𝑚2 ∗ °𝐶
∗ (640 − 20)°𝐶 

𝑞 = 516.667 
𝑊

𝑚2
 

Cálculo de Q 

𝑄 = 𝑞 ∗ 𝐴 

𝑄 = 516.667
𝑊

𝑚2  ∗ 0.029𝑚2 

𝑄 = 14.98 𝑊 

Cálculo de T 

𝑄 = ℎ ∗ 𝐴 ∗ (𝑇 − 20) 



 
 

 

Jessica Mayli Gaona Cumbicos, Kelly Dayanna Naula Duchi  Página 103  

14.983 𝑊

5
𝑊

𝑚2 °𝐶
∗ 0.029 𝑚2

+ 20 °𝐶 = 𝑇 

𝑇 = 123.33 °𝐶 

ANEXO 2: Cálculo de la porosidad del lecho 

𝐴𝑐 =
𝜋(0.03 𝑚)2

4
= 7.07 × 10−4𝑚2 

𝑉𝑙𝑒𝑐ℎ𝑜 = 𝜋(0.015 𝑚)2(0.01𝑚) = 7.07 × 10−6𝑚3 

𝑉𝑇𝑒𝑠𝑓 =
4

3
𝜋(5 × 10−4𝑚)3 ∗ 7340 = 3.84 × 10−6𝑚3 

𝜀 =
7.07 × 10−6𝑚3 − 3.84 × 10−6𝑚3

7.07 × 10−6𝑚3 = 0.46 

ANEXO 3: Cálculo del número de moles de los reactivos y productos de la 

gasificación 

Solución: 1.5 mL al 15% de glucosa en agua. 

Glucosa: 

𝑉𝐶6𝐻12𝑂6
= 1.5 𝑚𝐿 ∗ 0.15 = 0.225 𝑚𝐿 

𝑚𝐶6𝐻12𝑂6
= 0.225 𝑚𝐿 ∗ 1.56

𝑔

𝑚𝐿
= 0.398 𝑔 

𝑛𝐶6𝐻12𝑂6
=

0.398 𝑔

180
𝑔

𝑚𝑜𝑙

= 2.21 ∗ 10−3 𝑚𝑜𝑙𝑒𝑠 

Agua: 

𝑉𝐻2𝑂 = 1.5 𝑚𝐿 ∗ 0.85 = 1.275 𝑚𝐿 

𝑚𝐻2𝑂 = 1.275 𝑚𝐿 ∗ 1
𝑔

𝑚𝐿
= 1.275 𝑔 

𝑛𝐻2𝑂 =
1.275 𝑔

18
𝑔

𝑚𝑜𝑙

= 0.071 𝑚𝑜𝑙𝑒𝑠 
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Reactivo limitante: 

Para el agua: 

0.398 𝑔 𝐶6𝐻12𝑂6 ∗ 18 𝑔 𝐻2𝑂

180 𝑔 𝐶6𝐻12𝑂6
= 0.0398 𝑔 𝐻2𝑂  

Para la glucosa: 

180 𝑔 𝐶6𝐻12𝑂6 ∗ 1.275  𝑔 𝐻2𝑂

18 𝑔 𝐻2𝑂
= 12.75 𝑔 𝐶6𝐻12𝑂6 

El reactivo limitante es el agua. 

Metano: 

𝑛𝐶𝐻4
= 1.275 𝑔 𝐻2𝑂 ∗

1 𝑚𝑜𝑙 𝐻2𝑂

18 𝑔 𝐻2𝑂
∗

1 𝑚𝑜𝑙 𝐶𝐻4

1 𝑚𝑜𝑙 𝐻2𝑂
∗= 0.071 𝑚𝑜𝑙𝑒𝑠 

𝑚𝐶𝐻4
= 0.071 𝑚𝑜𝑙𝑒𝑠 ∗

16.04 𝑔

1 𝑚𝑜𝑙 𝐶𝐻4 
= 1.14 𝑔 

Hidrógeno: 

𝑛𝐻2
= 1.275 𝑔 𝐻2𝑂 ∗

1 𝑚𝑜𝑙 𝐻2𝑂

18 𝑔 𝐻2𝑂
∗

3 𝑚𝑜𝑙 𝐻2

1 𝑚𝑜𝑙 𝐻2𝑂
∗= 0.213 𝑚𝑜𝑙𝑒𝑠 

𝑚𝐻2
= 0.213 𝑚𝑜𝑙𝑒𝑠 ∗

2.016 𝑔

1 𝑚𝑜𝑙 𝐻2 
= 0.426 𝑔 

Dióxido de carbono: 

𝑛𝐶𝑂2
= 1.275 𝑔 𝐻2𝑂 ∗

1 𝑚𝑜𝑙 𝐻2𝑂

18 𝑔 𝐻2𝑂
∗

1 𝑚𝑜𝑙 𝐶𝑂2

1 𝑚𝑜𝑙 𝐻2𝑂
∗= 0.071 𝑚𝑜𝑙𝑒𝑠 

𝑚𝐶𝑂2
= 0.071 𝑚𝑜𝑙𝑒𝑠 ∗

44.01 𝑔

1 𝑚𝑜𝑙 𝐶𝑂2 
= 3.124 𝑔 

Agua: 

𝑛𝐻2𝑂 = 1.275 𝑔 𝐻2𝑂 ∗
1 𝑚𝑜𝑙 𝐻2𝑂

18 𝑔 𝐻2𝑂
∗
2 𝑚𝑜𝑙 𝐻2𝑂

1 𝑚𝑜𝑙 𝐻2𝑂
∗= 0.14 𝑚𝑜𝑙𝑒𝑠 

𝑚𝐻2𝑂 = 0.14 𝑚𝑜𝑙𝑒𝑠 ∗
18.02 𝑔

1 𝑚𝑜𝑙 𝐻2𝑂 
= 2.52 𝑔 
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Monóxido de carbono: 

𝑛𝐶𝑂 = 1.275 𝑔 𝐻2𝑂 ∗
1 𝑚𝑜𝑙 𝐻2𝑂

18 𝑔 𝐻2𝑂
∗

3 𝑚𝑜𝑙 𝐶𝑂

1 𝑚𝑜𝑙 𝐻2𝑂
∗= 0.213 𝑚𝑜𝑙𝑒𝑠 

𝑚𝐶𝑂 = 0.213 𝑚𝑜𝑙𝑒𝑠 ∗
28.01 𝑔

1 𝑚𝑜𝑙 𝐶𝑂 
= 0.852 𝑔 

Carbono: 

𝑛𝐶 = 1.275 𝑔 𝐻2𝑂 ∗
1 𝑚𝑜𝑙 𝐻2𝑂

18 𝑔 𝐻2𝑂
∗

1 𝑚𝑜𝑙 𝐶

1 𝑚𝑜𝑙 𝐻2𝑂
∗= 0.071 𝑚𝑜𝑙𝑒𝑠 

𝑚𝐶 = 0.071 𝑚𝑜𝑙𝑒𝑠 ∗
12 𝑔

1 𝑚𝑜𝑙 𝐶𝑂 
= 0.852 𝑔 

ANEXO 4: Cálculo del flujo moles de los productos de la gasificación 

Metano: 

𝑛̇𝐶𝐻4
=

0.071 𝑚𝑜𝑙𝑒𝑠

25 𝑠
= 2.84 × 10−3

𝑚𝑜𝑙𝑒𝑠

𝑠
 

Hidrógeno: 

𝑛̇𝐻2
=

0.213 𝑚𝑜𝑙𝑒𝑠

25 𝑠
= 8.51 × 10−3

𝑚𝑜𝑙𝑒𝑠

𝑠
 

Dióxido de carbono: 

𝑛̇𝐶𝑂2
=

0.071 𝑚𝑜𝑙𝑒𝑠

25 𝑠
= 2.84 × 10−3

𝑚𝑜𝑙𝑒𝑠

𝑠
 

Agua: 

𝑛̇𝐻2𝑂 =
0.14 𝑚𝑜𝑙𝑒𝑠

25 𝑠
= 5.59 × 10−3

𝑚𝑜𝑙𝑒𝑠

𝑠
 

Monóxido de carbono: 

𝑛̇𝐶𝑂 =
0.213 𝑚𝑜𝑙𝑒𝑠

25 𝑠
= 8.52 × 10−3

𝑚𝑜𝑙𝑒𝑠

𝑠
 

Carbono: 

𝑛̇𝐶 =
0.071 𝑚𝑜𝑙𝑒𝑠

25 𝑠
= 2.84 × 10−3

𝑚𝑜𝑙𝑒𝑠

𝑠
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ANEXO 5: Cálculo del número de Reynolds del fluido gasificante 

𝑅𝑒 =
6.45 × 10−3 𝑚

𝑠
 ∗ 9.25 × 10−3𝑚

1.45 × 10−7   𝑚2

𝑠

= 411.47 

El cual es menor que el número de Reynolds crítico de 2300. Por lo tanto, se trata de un 

flujo laminar. 

ANEXO 6: Cálculo del coeficiente de transferencia de calor del agente gasificante 

𝐴𝑠 = 𝜋 ∗ (9 × 10−3𝑚) ∗ (0.17𝑚) = 4.94 × 10−3𝑚2 

ℎ =
0.65

𝑊
𝑚. °𝐶

9.25 × 10−3𝑚
∗ 3.66 = 250.86

𝑊

𝑚. °𝐶
 

ANEXO 7: Cálculo de la temperatura de salida del agente gasificante 

𝑚̇ = 840.3
𝑘𝑔

𝑚3 ∗
𝜋(9 × 10−3𝑚)2

4
∗ 6.45 × 10−3

𝑚

𝑠
= 3.64 × 10−4

𝑘𝑔

𝑠
 

𝑇𝑒 = 350 °𝐶 − (350°𝐶 − 76.7 °𝐶)𝑒

− 
4.94 ×10−3𝑚2∗250.86

𝑊
𝑚.°𝐶

3.64×10−4𝑘𝑔
𝑠 ∗4610

𝐽
𝐾𝑔.°𝐶 = 210.41 °𝐶 

ANEXO 8: Cálculo de la caída de presión 

𝑉0 =
4.33 × 10−7 𝑚3

𝑠
7.07 × 10−4𝑚2 = 6.12 × 10−4

𝑚

𝑠
 

𝜕𝑝

𝜕𝑥𝑖
=

150 (6.12 × 10−4 𝑚
𝑠
) (2.5859 × 10−5𝑃𝑎. 𝑠)

(1)2(1 × 10−3)2
∗
(1 − 0.46)2

0.463

+
1,75 ∗ 0.2992 ∗  (6.12 × 10−4 𝑚

𝑠
)
2

(1)(1 × 10−3)
∗
(1 − 0.46)

0.463 = 7.11
𝑃𝑎

𝑚
 

Considerando una caída de presión y velocidad bastante pequeña, el factor de 

coeficiente cuadrático tenderá a cero. 

𝐾𝑄 = 0 

ANEXO 9: Cálculo de la densidad de área interfacial 

𝜎 =
7.07 × 10−4𝑚2 ∗ 0.46

𝜋(0.015𝑚)2 ∗ 0.066 𝑚
= 7.67 𝑚−1 
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ANEXO 10: Cálculo del número de Reynolds para en el fluido a través del reactor 

𝑅𝑒 =
1.33 × 10−3 𝑚

𝑠
 ∗ 0.03

8.301 × 10−5   𝑚2

𝑠

= 0.480 

El cual es menor que el número de Reynolds crítico de 2300. Por lo tanto, se trata de un 

flujo laminar. 

ANEXO 11: Cálculo del coeficiente de transferencia de calor del fluido en el reactor 

𝐴𝑠 = 𝜋 ∗ (0.03𝑚) ∗ (0.17𝑚) = 6.22 × 10−3𝑚2 

ℎ =
0.50

𝑊
𝑚. °𝐶

0.03𝑚
∗ 3.66 = 7.198

𝑊

𝑚. °𝐶
 

ANEXO 12: Cálculo de la temperatura de salida del fluido 

𝑚̇ = 0.3261
𝑘𝑔

𝑚3 ∗
𝜋(0.03 𝑚)2

4
∗ 1.33 × 10−3

𝑚

𝑠
= 3.07 × 10−7

𝑘𝑔

𝑠
 

𝑇𝑒 = 637.2 °𝐶 − (637.2 °𝐶 − 210.41 °𝐶)𝑒

− 
6.22 ×10−3𝑚2∗7.198

𝑊
𝑚.°𝐶

3.07×10−7×10−3𝑘𝑔
𝑠 ∗2088.61

𝐽
𝐾𝑔.°𝐶 = 637.2 °𝐶 

ANEXO 13: Cálculo de la velocidad esperada del fluido en el reactor 

𝑉2 =
4.33 × 10−7 𝑚3

𝑠
7.07 × 10−4 ∗ 0.46

= 1.33 × 10−3
𝑚

𝑠
 

 

 

 

 

 

 

 

 

 

 


